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History 
 
The word Computer in earlier times meant a person who 
performed calculations or computations. With years its 
definition changed to a machine that performs calculations. It 
can perform all type of mathematical and logical operations; 
it can accept data, store data, retrieve data, process data and 

produce output. Charles Babbage was known as father of 
computer. He invented two machines in 1822 introduced 
Difference 
Engine and in 1834, introduced Analytical engine 

 
ENIAC was the first digital computer and it was 
invented by J.Presper Eckert and John Mauchly at the 
University of Pennsylvania and began construction in 
1943. It uses 18000 vacuum tubes as a storing device. 
They were also founders of the first computer company, 
it was initially named Electronic Controls Company 

which was later changed to Eckert– Mauchly 
Computer Corporation, and released a series of 
mainframe electronic digital stored-program 
computer under the name of UNIVAC. MIT introduces 
the whirlwind machine (first computer with RAM) on 
March 8, 1955 

Generation of Computer 
 

Subject 1st generation 2nd generation 
3rd 

generation 
4th generation 5th generation 

Period 1940-1956 1956-1963 1964-1971 1971-present present & beyond 

Circuitry Vacuum tube Transistor 
Integrated 
chips (IC) 

Microprocessor 
(VLSI) 

ULSI (Ultra Large 
Scale Integration) 

technology 

Memory 
Capacity 

20 KB 128KB 1MB 
Semiconductor type 

and very high 
VLSI and ULSI 

Processing 
Speed 

300 IPS inst. Per 
sec. 

300 IPS 
1MIPS(1 

million inst. 
Per sec.) 

Faster than 3rd 

generation 
Very fast 

Programming 
Language 

Assembly 
Language 

High level 
language 

(FORTRAN, 
COBOL, ALGOL) 

C,C++ C,C++,Java 
All the Higher level 

languages, 
Neural networks, 

Example of 
computers 

UNIVAC, EDVAC 

IBM 1401, IBM 
7094, CDC 

3600,D UNIVAC 
1108 

IBM 360 
series, 

1900 series 

Pentium series 
Multimedia, 
Stimulation 

Artificial 
Intelligence, 

Robotics 
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Types of computer 
 

 

Hardware and I/O Devices 
 
Analog computer introduced by Lord Kelvin. Numerical data 
are represented by measurable physical variables such as 
electrical voltage. A thermometer is a simple analog 
computer. 
Digital computer that accepts and process data in the form of 
numbers and all the character are converted into binary code. 
Hybrid computer used the combined feature of analog and 
digital machine. you can see hybrid computer in geological 
departments. 
Microcomputer these are small relatively 
inexpensive computer designed for personal and office 
use. It has loweststoring and processing speed. These 
can be laptop or desktop. 
Minicomputer powerful as compare to 
microcomputer it has higher memory provide faster 
operating speeds and large storage capacities than 
microcomputers. It can be used as a server and capable 
of supporting from 2 to 200 users. 
Mainframe computer it has very high memory and 
processing speed and used as a server (can support 

thousands of users) 
Super computer can be used for complex type of 
applicationi.e. specific research, weather forecasting, Weapon 
designing etc 
CDC 6600 was the first successful supercomputer. 
Sunway TaihuLight of China is the fastest supercomputer in the 
world. 
PARAM-8000 India’s first Super Computer developed by C- DAC 
Pune in 1998. 
Shasra T is considered as India’s fastest super computer, 
manufactured by Indian Institute of Science. 
Servers are dedicated computers that serve the needs 
or request of other programs or computer. 
Workstations serve usually one user only. 
Information appliances are computers specially 
designed to perform a specific "user-friendly" 
function—such as playing music, photography. 
An embedded system is a computer system with a dedicated 
function within a larger system 
 

Memory Management 
 

8 bit 1 byte 

1024 Byte 1 KB (Kilo Byte) 

1024 KB 1 MB (Mega Byte) 

1024 MB 1 GB (Giga Byte) 

1024 GB 1 TB (Tera Byte) 

1024 TB 1 PB (Peta Byte) 

1024 PB 1 EB (Exa Byte) 

1024 XB 1 ZB (Zeta Byte) 

1024.ZB 1.YB (Yota Byte) 
 

 
A group of 4 bits is called a nibble. A byte is also known as an 
Octet. 
Primary Storage (memory), also known as main storage and 
it is the area in a computer in which data is stored for quick 
access by the computer's processor. The terms random access 
memory (RAM) and memory are often as synonyms for 
primary or main storage. Primary storage is volatile and can 
be contrasted with non-volatile secondary storage, also 
known as auxiliary storage. 
Cache memory is a smaller, faster memory which stores 

copies of the data from frequently used main memory 
locations. A CPU cache is a hardware cache used by the 
central processing unit (CPU) of a computer to reduce the 
average time to access data from the main memory. 
Secondary memory is where programs and data are kept on 
a long-term basis. Common secondary storage devices are the 
hard disk and optical disks. The hard disk has enormous 
storage capacity compared to main memory. The hard disk is 
usually contained inside the case of a computer. 
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Read-only memory (ROM) is a storage medium used in 
computers and other electronic devices. Data stored in ROM 
can only be modified slowly or with difficulty, or not at all. 
 
ROM is non-volatile and the contents are retained even after 
the power is switched off. 
It only allows reading. 
The types of ROM include PROM, EPROM and EEPROM. PROM 
- (programmable read-only memory) is a memory chip on 
which data can be written only once. 
The difference between a PROM and a ROM (read-only 
memory) is that a PROM is manufactured as blank 
memory, whereas a ROM is programmed during the 
manufacturing process. To write data onto a PROM 
chip, you need a special device called a PROM 
programmer or PROM burner. 
EPROM - (erasable programmable read-only memory) 
is a special type of PROM that can be erased by 
exposing it to ultraviolet light. 
EEPROM - (electrically erasable programmable read-
only memory). EEPROM is a special type of PROM that 
can be erased by exposing it to an electrical charge. 

Random Access Memory (RAM), allows the computer to 
store data for immediate manipulation and to keep 
track of what is currently being processed. 
 
RAM is referred to as volatile memory and is lost when 
the power is turned off. 
It also known as read/write memory as information 
can be read from and written onto it. 
The two main types of RAM are Static RAM and 
Dynamic RAM. 
 
SRAM retains data as long as power is provided to the 
memory chip and need not be refreshed periodically. 
It is often used as CPU Cache memory. SRAM stands for 
Static Random Access Memory. 
 
The data on DRAM continues to move in and out of the 
memory as long as power is available and must be 
continually refreshed to maintain the data. DRAM 
stands for Dynamic Random Access Memory. 
 

 
Virtual memory is memory on the hard disk that the CPU uses as an extended RAM. 

 
 

 Access Time Storage Capacity Cost per bit of storage 
Primary memory Faster Smaller High 
Secondary memory Slower Higher Low 

 
Memory can also be categorized on the basis of their material: 
 
Semiconductor memory:-such as RAM, ROM, EPROM, and 
flash memory. 
 
Magnetic memory:-such as hard disk, floppy disk and 
magnetic tapes. 
 
Optical memory:-such as computer disk, DVD and blue-
ray disk. 
A bus, in computing, is a set of physical connections 
(cables, printed circuits, etc.) which can be shared by 
multiple hardware components in order to 
communicate with one another. 
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The address bus (sometimes called the memory bus) 
transports memory addresses which the processor 
wants to access in order to read or write data. It is a 
unidirectional bus. 
The data bus transfers instructions coming from or 
going to the processor. It is a bidirectional bus. 

The control bus (or command bus) transports orders and 
synchonisation signals coming from the control unit and 
travelling to all other hardware components. It is a 
bidirectional bus, as it also transmits response signals from 
the hardware. 
 

Software and Operating System 
 
A set of instructions that tells the computer about the tasks to 
be performed and how these tasks are to performed, is 
known as Software. 
The set of instructions, which control the sequence of 

operations, are known as Program. It is a sequence of 
instructions, written to perform a specified task with a 
computer. 

 
 

Application software is a group of program designed for 
fulfill the demand of end user e.g. MS office, PowerPoint, 
Windows Media Player. 
System software is a program which is created for the 
system and to make the system user friendly such as 
operating system or is a type of computer program that is 
designed to run a computer's hardware and application 
programs. 
Utility software designed to help analyze, configure, 
optimize or maintain a computer such antivirus software. 
Operating system is a set of programs that help in 
controlling and managing the hardware and the 
software resources of a computer system. Main 
functions of operating system are 
-Process management 
-Memory management 
-File management 
-Security 
-Command and interpretation 
-Resource allocation 
 
Types of OS. 
1. Batch operating system : Here data and program 

that need to be processed are bundled and 
collected as a batch and executed together. 

2. Multiprogramming operating system : It allows 
the instruction and data from two or more 
separate process to reside in primary 
simultaneously. Multiprogramming system are 
multitasking multiuser and multiprocessing 
operating system. 
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3. Single user : It is designed for single user and a 
single person use it at a time i.e. DOS window’s 95 
etc. 

4. Distributed operating system : It is the one 
which manages a collection of independent 
computers and makes them appear to the user of 
the system as a single computer. 5)Real Time 
Operating System (RTOS) : It is a computing 
environment that reacts to input within a specific 
time period. It is used at those Places in which we 
Requires higher and Timely Response. 

5. Time Sharing System: A time sharing system allows 
the many users to simultaneously share the 
computer resources. Since each action or 
command in a time-shared system take a very 
small fraction of time, only a little CPU time is 
needed for each user. 

Mobile OS: Windows 10 Mobile is the latest name for 
Microsoft's phone and tablet operating system. Google's 
latest’s version of its android OS is Nougat and iOS i.e. iPhone 
Operating System's latest version is iOS 10 
 

 

Computer Languages 
 
 
Low level language: these are coded in a form which is easy to 
understand by the processor. 

 
Machine language: it is also a type of low level language 
these can be develop in binary language (0 and 1) . 
 
Assembly language: it is also a type of low level language and 
using the human readable instruction of the CPU. It is written 
as ‘MOV A.’ 
 
High level language programmer can write code in simple easy 
language, it is user friendly . E.g. C, JAVA 

 
C language: it is a middle level programming language and 
also known as procedural language 
C++ is high level language that uses the OOPS concept. 
 
Fortran: it is known as formula translation. It is used for 
scientific application 
 
COBOL (Common Business Oriented Language ): used for record 
keeping and data management in business organizations.  

 
BASIC (Beginner’s All Purpose Symbolic Instruction Code): 
first language designed for non-professional programmers. 

PASCAL: it is developed as a teaching tool for programming 
concepts. 
 
Simula was the first object-oriented programming language. 
Java, Python, C++, Visual Basic .NET and Ruby are the most 

popular Object Oriented Programming languages. The Java 
programming language is designed especially for use in 
distributed applications on corporate networks and the 
Internet. Ruby is used in many Web applications. Curl, 
Smalltalk, Delphi and Eiffel are also examples of object- 
oriented programming languages. 

convert program into a machine language so 
translator do this work. 
 
Loader: It loads the code which is translated by 
translator into the main memory and makes it ready to 
execute. 
 
Linker is used to combine all the object files and 
convert them into a final executable program. 
 
Interpreter converts high level language program 
into machine language. It is very slow because it convert 
program line by line. 
 
Compiler: It also translates the program from high 
level language to machine language. It is very fast 
because it converts the whole program into machine 
language. 
 
Assembler: It is used for converting the code of low 
level language (assembly language) into machine level 
language. Language processor (Translator): 
Programmers write their program in one of the high 
level language because it is much easy to code in these 
language but computer does not understand any of 
these language so it is necessary to 
 

Programming Language 
 

Programming Language are coded language are 
coded language used by programmer to write 
instructions that a computer can understand to what 
the Programmer want. 

 

Following are the major categories of Programming 
Languages − 

• Machine Language 
• Assembly Language 
• High Level Language 
• System Language 
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• Scripting Language 
 
Pseudo code -  
 
Pseudo code is a simple way of writing programing code 

in english. 
 
For example – Task – Add two Numbers --- 
• Start 
• Get two numbers  
• Add them 
• Print the answer  
• End  
 
Flow chart  
 
A flow chart is a graphical or symbolic representation of 

a process. Each step in the process is represented by a 
different symbol and contains a short description of the 
process step. 

Different flow chart symbols have different meanings. 
The most common flow chart symbols are: 
• Terminator: An oval flow chart shape indicating the 

start or end of the process. 
• Process: A rectangular flow chart shape indicating a 

normal process flow step. 
• Decision: A diamond flow chart shape indication a 

branch in the process flow. 
• Connector: A small, labeled, circular flow chart 

shape used to indicate a jump in the process flow. 
(Shown as the circle with the letter "A", below.) 

• Data: A parallelogram that indicates data input or 
output (I/O) for a process. 

• Document: Used to indicate a document or report 
(see image in sample flow chart below). 

 
What is Algorithm 
 
An algorithm is a well-defined procedure that allows a 

computer to solve a problem. Another way to describe 
an algorithm is a sequence of unambiguous instructions. 
... In fact, it is difficult to think of a task performed by 
your computer that does not use algorithms. 

Sequence of program –  
 
• Algorithm  
• Flowchart  
• Program (source code) 
• Compiling  
• Object code 
 
What is syntax -    way to write any instruction in any 

programming language with the help of some special 
symbols and character.  

 
Types of Programming Language 
 

 
 
• Machine language  
Machine language is written in binary language. It is 

consists of 0s and 1s. Machine language is dependent 
programming language. It is first generation 
programming language. It does not require translator. 
Machine Language is easy to understand for computer 
but difficult to programmer. 

The program is written in machine is called object code. 
It has two part – 
Opcode – Operation code – an opcode is a single 

instruction that can be executed by the CPU. 
Operand (address part) – operands are manipulated by 

opcode  
 
• Assembly Language -  
Assembly language used mnemonic code in place of 

binary language. It is second generation programming 
language. An assembly language is a low-level 
programming language designed for a specific type of 
processor. Assembly languages generally lack high-level 
conveniences such as variables and functions. 

 
• High level Language -  
A high-level language (HLL) is a programming language 
such as C, FORTRAN, or Pascal that enables a programmer 
to write programs that are more or less independent of a 
particular type of computer. It is independent 
programming language. It is third Generation 
programming language. The program is written in high 
level is called source code. FORTAIN was first high level 
language. 

 
 
➢ FORTRAN 
Full form Formula Translation. It was first high-level 
language. It was introduced by John Backus in 1957. It is 
used for scientist and engineers. 
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➢ ALGOL 
ALGOL is short for algorithmic language. It is an 
early high-level computer programming language 
devised to carry out scientific calculations. ALGOL 
was used as the standard method for creating 
algorithms. First appeared in 1958. ALGOL language 
designed by: Friedrich L. Bauer, Hermann 
Bottenbruch 

 
➢ COBOL 

The name COBOL stands for Common Business-
Oriented Language. COBOL is a programming 
language that was developed in the year 1959.  It 
was one of the first computer programming 
languages used for commercial. It was introduced by 
Grace Hopper. 

 
➢ BASIC(Beginner's All-purpose Symbolic 

Instruction Code)  
BASIC. Stands for "Beginner's All-purpose Symbolic 
Instruction Code”. BASIC is a computer 
programming language that was developed in the 
mid-1960s to provide a way for students to write 
simple computer programs. In 1964, John G. Kemeny 
and Thomas E. Kurtz designed the original BASIC 
language at Dartmouth College. 

 
➢ Pascal  

Pascal is an imperative and procedural 
programming language, designed by Niklaus Wirth 
as .... Apollo Computer used Pascal as the systems 
programming language for its operating systems 
beginning in 1980. It is named in honor of the French 
mathematician, philosopher and physicist Blaise 
Pascal. 

 
➢ C Language 

C is a general-purpose, procedural computer 
programming language supporting structured 
programming, lexical variable scope, and recursion, 
while a static type system prevents unintended 
operations. C was developed at Bell Labs by Dennis 
Ritchie for the Unix Operating System in the early 
1970s. It is also called middle level language. 

 
➢ C++ Language 

C++ is a High-level programming language 
developed by Bjarne Stroustrup starting in 1979 at 
Bell Labs.  C++ runs on a variety of platforms, such as 
Windows, Mac OS, and the various versions of UNIX. 
This C++ tutorial adopts a simple and practical 
approach to describe the concepts of C++ for 
beginners to advanced software engineers. C++ fully 
supports object-oriented programming, including 
the four pillars of object-oriented development. 

 
➢ JAVA 

Java is a programming language and a platform. Java 
is a high level, robust, object-oriented and secure 

programming language. Java is introduced by James 
Gosling. Java is used many application like ………. 

1. Desktop Applications such as acrobat reader, media 
player, antivirus, etc. 

2. Web Applications such as irctc.co.in, javatpoint.com, 
etc. 

3. Enterprise Applications such as banking 
applications. 

4. Mobile 
5. Embedded System 
6. Smart Card 
7. Robotics 
8. Games, etc. 
 
➢ PERL(Practical Extraction and Reporting 

Language) 
Perl is a general-purpose programming language 
originally developed for text manipulation and now 
used for a wide range of tasks including system 
administration, web development, network 
programming, GUI development, and more. Perl was 
originally developed by Larry Wall in 1987. Stand for 
"Practical Extraction and Reporting Language 

 
➢ Python  

Python is a general purpose and high level 
programming language. You can use Python for 
developing desktop GUI applications, websites and 
web applications. It is introduced by Guido van 
Rossum. 

 
➢ C# Language 

C# can be used to create almost anything but is 
particularly strong at building Windows desktop 
applications and games. C# can also be used to 
develop web applications and has become 
increasingly popular for mobile development too. It 
is developed by Microsoft. C# is an object-oriented 
programming language used with XML-based Web 
services on the .NET platform and designed for 
improving productivity in the development of Web 
applications. 
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Scripting Language  
Scripting languages are server-side scripting 
languages that manipulate the data, usually in a 
database, on the server. Scripting languages came 
about largely because of the development of the 
Internet as a communications tool.  
Html, Xml, JavaScript, ASP, JSP, PHP, Perl, Tcl and 
Python are examples of scripting languages. 

 
Language Translator –  

Language translator is a program which is used to 
translate instructions that are written in the source 
code to object code i.e. from high-level language or 
assembly language into machine language. 
There are 3 different types of translators as 

1. Assembler- Assembler are used to convert assembly 
language code into machine code.  Assembler 
convert mnemonic code in to object code. 

2. Compiler- Compiler translate high level language in 
machine language. It read the entire program. It 
finds the syntax error. Error in a program is called 
bug. Compiler convert source code into object code. 

3. Interpreter- An interpreter translates high-level 
instructions into an intermediate form, which it then 
executes.  It reads the program line by line. In 
contrast, a compiler translates high-level 
instructions directly into machine language. 
Compiled programs generally run faster than 
interpreted programs. 

 

Number System 
 
The radix or base is the number of unique digits, including 
zero, used to represent numbers in a positional numeral 
system. For example, for the decimal system the radix is ten, 
because it uses the ten digits from 0 through 9. And that of 
Binary is base 2. 
 
Number System 

Decimal, Binary, Octal and Hexadecimal 
Equivalents 

Decimal Binary Octal Hexadecimal 
0 0000 000 0 
1 0001 001 1 
2 0010 002 2 
3 0011 003 3 
4 0100 004 4 
5 0101 005 5 
6 0110 006 6 
7 0111 007 7 
8 1000 010 8 
9 1001 011 9 
10 1010 012 A 
11 1011 013 B 
12 1100 014 C 
13 1101 015 D 
14 1110 016 E 
15 1111 017 F 

 
Hexadecimal to Binary: Refer the above table for the 
conversion process 
(1A2)16 = (?)2 
1=0001, A= 1010, 2=0010; Hence (1A2)16

 = 
(000110100010)2 

Decimal to Binary: (75)10 =(?)2 
Divide 75 by 2 (and write down its remainder). 

 
Hence (75)10 =(101011)2 
Any number system to decimal: 

Sum of all (Digit × (Base)Base’s Place) 
Example: (1A2)16 = (?)10 (From the table you can refer A 

is 
equivalent to 10) 

((1× 162)+(10 × 161)+ (2×160))= 256+160+2=418 
Example: (110110)2=(?)10 

((1×25)+ (1×24)+ (0×23)+ (1×22)+

 (1×21)+ 

(0×20))=32+16+4+2= 54; (110110)2=(54)10 
Octal to Binary: (345)8 =(?)2 (Write down 3 bit binary 
equivalents of all digits) 
3=011, 4=100, 5=101; Hence (345)8 =(011100101)2 

 
Octal to Hexadecimal: Convert to Binary first and then
 
=(?)16 =>(345)8 =(011100101)2 = 0000 1110 0101 

=(0E5)16 group 4 bits to get hexadecimal number. 

Example: (345)8 
 

Computer Network 
 
Different types of network are: LAN, MAN and WAN. 
A LAN (local area network) is a group of computers and 
network devices connected together, usually within the same 

building. By definition, the connections must be high speed 
and relatively inexpensive (e.g., token ring or Ethernet). 
A MAN (metropolitan area network) is a larger network that 
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usually spans several buildings in the same city or town. A 
WAN (wide area network), in comparison to a MAN, is not 
restricted to a geographical location, although it might be 
confined within the bounds of a state or country. A WAN 
connects several LANs, and may be limited to an enterprise (a 
corporation or an organization) or accessible to the public. The 
technology is high speed and relatively expensive. The 
Internet is an example of a worldwide public WAN. 
A personal area network (PAN) is a computer network 
used for data transmission amongst devices such as 
computers, telephones, tablets and personal digital 
assistants. 
Campus Area Network or corporate area network is a 
computer network made up of an interconnection of local 
area networks (LANs) within a limited geographical area. 
A Storage Area Network (SAN) is a specialized, high-speed 
network that provides block-level network access to storage. A 
virtual private network (VPN) extends a private network 
across a public network, such as the Internet. It enables users 
to send and receive data across shared or public networks as 
if their computing devices were directly connected to the 
private network. 
Networking Devices 
Modem: Modem stands for Modulator-Demodulator. It is 
used to connect computers for communication via telephone 
lines. 
Hub: It works at the Physical layer. It just acts like a 
connector of several computers i.e. simply connects all the 
devices on its ports together. It broadcasts all the data 
packets arriving at it with no filtering capacity. 
 
Switch: It works at the Data Link Layer. It is used for dividing 
a network into segments called subnets. It provides filtering of 
data packets and prevents network traffic also. 
 
Repeater: It operates at the Physical Layer. It is used to 
amplify a signal that has lost its original strength so as to 
enable them to travel long distances. 
Router: It works at the Network Layer and is used to connect 
different networks that have different architectures and 
protocols. It sends the data packets to desired destination by 
choosing the best path available thus reducing network traffic. 
Gateway: It operates in all the layers of the network 
architecture. It can be used to connect two different networks 
having different architectures, environment and even 
models. 
Bridge: They are used two connect two LANs with the same 
standard but using different types of cables. It provides an 
intelligent connection by allowing only desired 
messages to cross the bridge thus improving 
performance. It uses physical addresses of the packets 
for this decision. 
 
IPv4 - 32 bits numeric address 
IPv6 - 128 bits hexadecimal address 
IPv6 does not use broadcast messages and has three 
types of addresses, which are categorized as : 
Unicast addresses. A packet is delivered to one 
interface. Multicast addresses. A packet is delivered 

to multiple interfaces. 
Anycast addresses. A packet is delivered to the 
nearest of multiple interfaces (in terms of routing 
distance). 
With an IPv4 IP address, there are five classes of 
available IP ranges: Class A, Class B, Class C, Class D and 
Class E, while only A, B, and C are commonly used. Each 
class allows for a particular range of valid IP addresses. 
Class D is reserved for multicast groups and Class E is 
reserved for future use, or Research and Development 
Purposes. 
Data Communication deals with the transmission of 
digital data from one device to another. Data is 
transferred through a pathway called as 
communication channel which can be physical wire 
connecting the devices or may be unguided media like 
laser, microwave etc. 
A communication channel has a source or transmitter 
at one side and a designation or receiver at another 
side of the network. The source of data origination is 
single but there may be multiple receivers. A 
communication channel is of 3 types: 
 
Simplex: This, communication is unidirectional i.e. 
one of the two devices can transmit the data and the 
other can only receive the data. For e.g. Radio 
broadcasting, television broadcasting etc. 
 
Half duplex: This communication is bidirectional. 
Either of the devices can act as transmitter or receiver 
but only one device can transmit the data at one time. 
For e.g. Walkie- Talkie. 
 
Full Duplex: Here the communication is in both 
directions and both the devices can simultaneously 
transmit the data. For e.g. Telephone conversation. 
 
The Open Systems Interconnection model (OSI) is a 
conceptual model that characterizes and standardizes 
the internal functions of a communication system by 
partitioning it into abstraction layers. The model is a 
product of the Open Systems Interconnection project 
at the International Organization for 
Standardization (ISO). 
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Network topology is the arrangement of the various 
elements (links, nodes, etc.) of a computer network. 
There are two basic categories of network topologies: 

 Physical topologies and Logical topologies. 
Physical topology is the placement of the various 
components of a network, including device location 
and cable installation, while Logical topology 
illustrates how data flows within a network, 
regardless of its physical design. Various types of 
topologies are:

 

 
 
Hybrid topology uses a combination of any two or more 
topologies in such a way that the resulting network does not 
exhibit one of the standard topologies. 
 
Cloud computing is a type of Internet-based computing that 
provides shared computer processing resources and data to 
computers and other devices on demand. 
 
Public clouds are owned and operated by companies that 
offer rapid access over a public network to affordable 
computing resources. 
A private cloud is infrastructure operated solely for a single 
organization, whether managed internally or by a third party, 

and hosted either internally or externally. 
 
A hybrid cloud uses a private cloud foundation 
combined with the strategic integration and use of 
public cloud services. 
 
Google Drive is a personal cloud storage service from 
Google which gives every user 15 GB of Drive storage 
space. OneDrive is Microsoft's service for hosting files 
in the "cloud computing". OneDrive offers 5GB of 
storage space for free. 
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Internet 
 
The Internet is a global system of interconnected computer 
networks that use the standard Internet protocol suite 
(TCP/IP) to link several billion devices worldwide. 
It is a network of networks that consists of millions of 
private, public, academic, business, and government 
networks, of local to global scope, that are linked by a broad 
array of electronic, wireless, and optical networking 
technologies. 
ARPANET adopted TCP/IP in 1983, and from there 
researchers began to assemble the “network of networks” 
that became the modern Internet. 
The World Wide Web (abbreviated as WWW or W3, 
commonly known as the Web) is a system of interlinked 
hypertext documents that are accessed via the Internet. 

A Website is a set of related web pages served from a single 
web domain. 
A Home page, index page, or main page is a page on a 
website. A home page usually refers to: 
• The initial or main web page of a website, sometimes 

called the "front page" (by analogy with newspapers). 
• The first page that appears upon opening a web browser 

program, which is also sometimes called the start page. 
This 'start page' can be a website or it can be a page with 
various browser functions such as the visual display of 
websites that are often visited in the web browser. 

• The web page or local file that automatically loads when a 
web browser starts or when the browser's "home" 
button is pressed; this is also called a "home page". The 
user can specify the URL of the page to be loaded, or 
alternatively choose e.g. to re-load the most recent web 
page browsed. 

• A personal web page, for example at a web hosting 
service or a university web site that typically is stored 
in the home directory of the user. 

A Hyperlink is a reference to data that the reader can directly 
follow either by clicking or by hovering or that is followed 
automatically 

A web browser (commonly referred to as a browser) is a 
software application for retrieving, presenting and 
traversing information resources on the World Wide Web. 
Some of the famous browsers are Safari, Chrome, Firefox, Bolt, 
UC Browser and Internet Explorer 
The Uniform Resource Locator, abbreviated as URL is a 
specific character string that constitutes a reference to a 
resource. In most web browsers, the URL of a web page is 
displayed on top inside an address bar. 
(i) An example of a typical URL would be 
"http://www.bankersadda.com". 
Here the domain name is ‘bankersadda.com’ 
Downloading means to receive data to a local system from a 
remote system or to initiate such a data transfer 
 

Uploading refers to the sending of data from a local system to 
a remote system such as a server or another client with the 
intent that the remote system should store a copy of the data 
being transferred 
 
An Internet Protocol address (also known as an IP 
address) is a numerical label assigned to each device (e.g., 
computer, printer) participating in a computer network. It 
acts as an identifier for a computer. It is a unique address for 
every computer. 
 
Domain names are used to identify one or more IP 
addresses. 
 
The universal resource locator, or URL, is an entire set of 
directions, and it contains extremely detailed information. 
The domain name is one of the pieces inside of a URL. 
 

 
 
An email attachment is a computer file sent along with an 
email message. One or more files can be attached to any email 
message, and be sent along with it to the recipient. 
Hotmail was co-founded by an Indian American 

entrepreneur Sabeer Bhatia along with Jack Smith in July of 

1996 CC (Carbon Copy) in e – mail indicates those who are 

to receive a copy of a message addressed primarily to another 

The list of CC recipients is visible to all other recipients of the 

message 

An additional BCC (blind carbon copy) field is available for 

hidden notification; recipients listed in the BCC field receive a 

copy of the message, but are not shown on any other 

recipient's copy (including other BCC recipients) 

The Drafts folder retains copies of messages that you 
have started but are not yet ready to send. 
 
The first email was sent by Ray Tomlinson to himself 
in 1971. 

Internet  Explorer  was  deprecated  in  Windows  10,  
with 

Microsoft Edge replacing it as the default web browser. 
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Computer Security 
 
A Computer Virus is a computer program or code that can 
replicate itself and spread from one computer system to 
another system. A computer virus has the capacity to corrupt 
or to delete data on your computer and it can utilize an e- mail 
program to spread the virus to other computer systems 
.In the worst case scenario, it can even delete everything on 
your hard disk .The purpose of it is to disrupt the operation of 
the computer or the program. 
 
Some examples of Computer Virus are Trojan viruses. 
Stealth viruses, worms, malware (malicious software), Disk 
Killer, Stone virus, Sunday, Cascade, Nuclear, Word Concept, 
etc. 

 
Malware, short for malicious software, is any software used 
to disrupt computer operation, gather sensitive information, 
or gain access to private computer systems. It can appear in 
the form of executable code, scripts, active content, and other 
software. 
 
Antivirus Software is used to scan the hard disk to remove the 
virus from them. Some of the famous anti – viruses available 
are Avast, Norton, Avira, Kaspersky, AVG, etc. 
A person who uses his or her expertise to gain access to other 
people’s computers to get information illegally or do damage 

is a Hacker. 
Authorization is the function of specifying access 
rights to resources related to information security and 
computer security in general and to access control in 
particular. More formally, "to authorize" is to define an 
access policy. 
 
Authentication is the act of confirming the truth of an 
attribute of a single piece of data or entity. It might 
involve confirming the identity of a person by 
validating their identity documents, verifying the 
validity of a website with a digital certificate, tracing 
the age of an artifact by carbon dating, or ensuring that 
a product is what its packaging and labeling claim to 
be. In other words, Authentication often involves 
verifying the validity of at least one form of 
identification. 
 
Phishing is the attempt to acquire sensitive 
information such as usernames, passwords, and credit 
card details (and sometimes, indirectly, money) by 
masquerading as a trustworthy entity in an electronic 
communication. 
A Spoofing attack is a situation in which one person or 
program successfully represents oneself as another by 
falsifying data and thereby gaining an illegitimate advantage. 

Microsoft Office 
 
Microsoft Office is an office suite of desktop applications, 
servers and services for the Microsoft Windows and Mac 
operating systems. It includes Microsoft Word, Excel, 
PowerPoint, Outlook, OneNote, Access and Publisher. 
Note: Microsoft Windows Vista was an windows OS for PC not 
Office Suit. 
 
Office 365 is a subscription service that includes the most 
recent version of Office, which currently is Office 2016. It 

comes with the applications you’re familiar with, like Word, 

PowerPoint, and Excel, plus extra online storage, ongoing tech 

support. 

 

Note- Microsoft Azure is a growing collection of integrated 

cloud services which developers and IT professionals use to 

build, deploy and manage applications through our global 

network of data centres. It provides software as a service 

(SaaS), platform as a service (PaaS) and infrastructure as a 

service (IaaS) and supports many different programming 

languages, tools and frameworks. Microsoft Azure was earlier 

known as Windows Azure. 

 

SOME NEW FEATURES INTRODUCED IN OFFICE 2016 FOR 
WINDOWS OS 
 
Share: In Word 2016 for Windows, it is easier than ever to 
share your documents. When you share your files by using 
OneDrive or SharePoint Online for Office 365, you can invite 
people to the document directly from within Word, or send a 
PDF or Word file as an email attachment. This feature of share 
is also available for Excel and PowerPoint 2016. 
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Tell Me: This is a text field where you can enter words and 
phrases about what you want to do next and quickly get to 
those features you want to use or actions you want to 
perform. You can also use Tell Me to find help about what 
you're looking for, or to use Smart Lookup to research or 
define the term you entered. 
Smart Lookup: Bing search incorporated with applications 
New Charts introduced in Excel 2016 : New Chart types and 
templates are introduced in Excel 2016 such as treemap, 
sunburst chart (also known as a ring chart), waterfall chart, 
box plot and histogram, and financial and calendar templates. 
Skype and OneDrive Integration : One of the new features 
added to Word, Excel, and PowerPoint is the ability to use 
Skype for Business to collaborate and communicate while 
working on documents. User can IM or video-call someone 
with Skype from the new Share pane built into the new Office 
applications. OneDrive integration supports cloud storage file 
hosting service that supports access of office document from 
anywhere on any device. 
Some other features: 
New animations in PowerPoint (such as the Morph 
transition), the ability to insert online video in OneNote, and 
a data loss prevention feature in Word, Excel, and PowerPoint. 
New recent-documents feature in Outlook 2016 shows you 
the documents you've recently worked on in the Office apps, 
so you don't have to hunt for them on your PC. 
Enterprise Data Protection: To manage and prevent data loss 
at enterprise level, MS Office 2016 comes paced with inbuilt 
security feature that provide an ease for system admin to 
enforce policies for content authoring and document sharing. 
 
SOME COMMANDS RELATED TO MS OFFICE 
 
1. Save Vs Save As  
"Save" simply saves your work by updating the last saved 
version of the file to match the current version you see on 
your screen. 
"Save As" brings up a prompt to save your work as a file with 
a different name. For example, you might choose to save a 
document called "New Doc" as "Final Doc". This way, you can 
save you file at different stages and keep multiple versions on 
your hard drive. 
2. Save or convert to PDF 
You can use the Office programs to save or convert your files 
to PDFs so that you can share them or print them using 
commercial printers. To export or save as PDF, in your Office 
file, on the File menu, click Export or Save As. 
3. Undo Vs Redo 
You can undo, redo, or repeat many actions in Microsoft Word, 
PowerPoint, and Excel. Undo reverses the immediate action. 
Redo reverts the effects of the undo action. 
4. Portrait Vs Landscape 
The terms portrait and landscape refer to different 
orientations of the paper; whether it is oriented vertically or 
horizontally. A page with portrait orientation, typical for 
letters, memos, and other text documents, is taller than it is 
wide. Portrait is vertical mode and landscape is horizontal 
mode. 

MS WORD 2016: 
Backstage View in MS Word 2016: MS Word 2016 has a 
backstage view where you can see the recent documents that 
you’ve visited or edited and a few templates as well. There is 
also an option to search for more templates. These templates 
can help you get the desired layout where a sample data will 
already be there. You may edit and enter data as you may like. 
 
MS Word 2016 Ribbons: 
 
Quick Access Toolbar 
By default, on top is the Quick access toolbar which has 3 
default options available: Save, Undo Typing and Repeat 
Typing. After this there is a drop-down menu for customizing 
the quick access toolbar. This toolbar is totally customizable; 
you can position it below the tabs and commands or add more 
items to it.  
 
To add or remove a command from the quick access toolbar: 
When you find a favorite command, right-click it, and then 
click Add to Quick Access Toolbar. 
 
Remove a command by right-clicking it on the Quick Access 
Toolbar, and then clicking Remove from Quick Access 
Toolbar. 
 
Tabs in Word 2016 
 
The ribbon in Word and other Office Suite’s Application has 
Tabs. In Word 2016 there are 9 tabs followed by a new feature 
of “Tell me what you want to do” arranged in a horizontal 
fashion. The tabs are as follows: File, Home, Insert, design, 
Layout, References, Mailing, Review, and View. The File tab 
opens the Info Window and has options arranged in a vertical 
array: Info, New, Open, Save, Save As, Print, Share, Export, 
Close, Account, Feedback and Options. 
 
The ribbon containing Tabs also have a new feature of Share 
and Comment at the extreme right corner. 
 
Note- Each tab has many commands which are grouped into 
specific categories. Following are the groups for commands 
under various tabs of MS Word 2016: 
Home: Clipboard, Font, Paragraph, Styles and Editing 
Insert: Pages, Tables, Illustrations, Add-ins, Media, Links, 
Comments, Header & Footer, Text, Symbols 
Design: Document Formatting, Page Background 
Layout: Page Setup, Paragraph, Arrange 
References: Table of Contents, Footnotes, Research, Citation & 
Bibliography, Captions, Index, Table of Authorities  
Mailings: Create, Start Mail Merge, Write &Insert Fields, 
Preview Results, Finish 
Review: Proofing, Accessibility, Language, Comments, 
Tracking, Changes, Compare, Protect 
View: Views, Page Movement, Show, Zoom, Window, Macros 
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MS WORD 2016 SHORT CUT KEYS 
 
Frequently used short cut keys 

To do this Press 

Go to "Tell me what you want to do" Alt+Q 

Open Ctrl+O 

Save Ctrl+S 

Close Ctrl+W 

Cut Ctrl+X 

Copy Ctrl+C 

Paste Ctrl+V 

Select all Ctrl+A 

Bold Ctrl+B 

Italic Ctrl+I 

Underline Ctrl+U 

Decrease font size 1 point Ctrl+[ 

Increase font size 1 point Ctrl+] 

Centre text Ctrl+E 

Left align text Ctrl+L 

Right align text Ctrl+R 

Justify align text Ctrl+J 

Cancel Esc 

Undo Ctrl+Z 

Re-do Ctrl+Y 

Zoom 

Alt+W, Q, then tab 
in Zoom dialog box 
to the value you 
want. 

Copy formatting from text. Ctrl+Shift+C 

Apply copied formatting to text. Ctrl+Shift+V 

 
Create and edit documents 

To do this Press 

Split the document window. Alt+Ctrl+S 

Remove the document window 
split. 

Alt+Shift+C or 
Alt+Ctrl+S 

Save a document. Ctrl+S 

 
Delete text and graphics 
To do this Press 

Delete one character to the left. Backspace 

Delete one word to the left. Ctrl+Backspace 

Delete one character to the right. Delete 

Delete one word to the right. Ctrl+Delete 

Cut selected text to the Office 
Clipboard. 

Ctrl+X 

Undo the last action. Ctrl+Z 

Cut to the Spike. (Spike is a feature 
that allows you to collect groups of 

Ctrl+F3 

text from different locations and paste 
them in another location). 

 
Find, replace and go to specific items in the document 

To do this Press 

Open the search box in the 
Navigation task pane. 

Ctrl+F 

Replace text, specific formatting, and 
special items. 

Ctrl+H 

Go to a page, bookmark, footnote, 
table, comment, graphic, or other 
location. 

Ctrl+G 

Switch between the last four places 
that you have edited. 

Alt+Ctrl+Z 

 
Work with documents in different views 

To do this Press 

Switch to Read Mode view Alt+W, F 

Switch to Print Layout view. Alt+Ctrl+P 

Switch to Outline view. Alt+Ctrl+O 

Switch to Draft view. Alt+Ctrl+N 

 
Change Paragraph Alignment 

To do this Press 

Remove a paragraph indent from the 
left. 

Ctrl+Shift+M 

Create a hanging indent. Ctrl+T 

Reduce a hanging indent. Ctrl+Shift+T 

Remove paragraph formatting. Ctrl+Q 

 
Insert Special Characters 

To insert this Press 

A field Ctrl+F9 

A line break Shift+Enter 

A page break Ctrl+Enter 

A column break Ctrl+Shift+Enter 

An em dash 
Alt+Ctrl+Minus Sign (on the 
numeric keypad) 

An en dash 
Ctrl+Minus Sign (on the numeric 
keypad) 

An optional hyphen Ctrl+Hyphen 

A nonbreaking 
hyphen 

Ctrl+Shift+Hyphen 

A nonbreaking space Ctrl+Shift+Spacebar 

The copyright symbol Alt+Ctrl+C 

The registered 
trademark symbol 

Alt+Ctrl+R 

The trademark 
symbol 

Alt+Ctrl+T 

An ellipsis Alt+Ctrl+Period 

A single opening 
quotation mark 

Ctrl+`(single quotation mark), 
`(single quotation mark) 
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A single closing 
quotation mark 

Ctrl+' (single quotation mark), ' 
(single quotation mark) 

Double opening 
quotation marks 

Ctrl+` (single quotation mark), 
Shift+' (single quotation mark) 

Double closing 
quotation marks 

Ctrl+' (single quotation mark), 
Shift+' (single quotation mark) 

An AutoText entry 

Enter (after you type the first 
few characters of the AutoText 
entry name and when the 
ScreenTip appears) 

 
MS POWERPOINT 2016: 
PowerPoint is a slideshow presentation program that's part 
of the Microsoft office suite of tools. PowerPoint slides can be 
plain with only text, or they can include pictures and even 
animation, including moving text and images. Text can be 
formatted in the same way as text can be formatted in 
Microsoft Word, including color, size, and font type. 
 
In PowerPoint 2016 there are 9 tabs followed by a new 
feature of “Tell me what you want to do” arranged in a 
horizontal fashion. The tabs are as follows: File, Home, Insert, 
design, Transition, Animation, Slide Show, Review, and View. 
 
1. Home  
The home tab in PowerPoint has following groups: Clipboard, 
Slides, Font, Paragraph, drawing and Editing. The Clipboard, 
Editing and Font commands are same as that in Word 2016. 
The Slides group contains commands to insert new slide, 
choose slide layout, reset the positions and formatting of the 
slide placeholders and option to organize your slides into 
sections. 
 
2. Insert 
Click Insert to add something to a slide. This includes pictures, 
shapes, charts, links, text boxes, video and more. The Insert 
Tab has following groups of commands: Slides, Tables, 
Images, Illustrations, Add-ins, Links, Comments, Text, 
Symbols and Media. 
 
3. Design 
On the Design tab, you can add a theme or color scheme, or 
format the slide background. The design tab has following 
categories or groups of commands:  
Themes- Each theme has its own unique set of font, effect, 
color to create a visually appeasing and overall look of the 
slide. 
Variants - The current theme or style can be customized using 
various color schemes through variants. 
Customize- This group contains commands to change slide 
size and Format Background. 
Designer- For instant slide makeovers. 
 
4. Transitions 
Set up how your slides change from one to the next on the 
Transitions Tab. Find a gallery of the possible transitions in 
the Transition to This Slide group – click More Button at the 
side of the gallery to see all of them. 
 

5. Animations 
User may use the Animations tab to choreograph the 
movement of things on his slides. Note that you can see many 
possible animations in the gallery in the Animation group, and 
see more of them by clicking  
More Button. Apart from adding animation you can also 
customize its duration and timing as you need by using 
advanced animation and timing group of commands. 
 
6. Slide Show 
On the Slide Show tab, set up the way that you want to show 
your presentation to others. 
 
7. Review 
The Review tab lets you add comments, run spell-check, or 
compare one presentation with another (such as an earlier 
version). 
 
8. View 
Views allow you to look at your presentation in different 
ways, depending on where you are in the creation or delivery 
process. 
 
9. File 
At one end of the ribbon is the File tab, which you use for the 
behind-the-scenes stuff you do with a file, such as opening, 
saving, sharing, exporting, printing and managing your 
presentation. Click the File tab to open a new view called the 
Backstage. 
 
10. Tools tabs 
When you click some parts of your slides, such as pictures, 
shapes, SmartArt or text boxes, you might see a colourful new 
tab appear. 
For example, the Drawing Tools tab appears when you click a 
shape or text box. When you click a picture, the Picture Tools 
tab appears. Other such tabs include SmartArt Tools, Chart 
Tools, Table Tools and Video Tools. These tabs disappear or 
change when you click something else in your presentation. 
 
Terms related to PowerPoint 
 
Slide Show : Each page of a PowerPoint presentation is called 
a slide. The default orientation of the slide is in landscape 
layout 
Design Template : A design template acts as a coordinated 
packaged deal. It is created so that even though different slide 
types can have different layouts and graphics, the whole 
presentation goes together as an attractive package. 
Slide Master : When you want all your slides to contain the 
same fonts and images (such as logos), you can make those 
changes in one place—the Slide Master, and they'll be applied 
to all your slides. To open Slide Master view, on the View tab, 
select Slide Master: 
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MS POWERPOINT 2016 SHORT CUT KEYS 
 
Frequently used shortcuts 
The following table itemizes the most frequently used 
shortcuts in PowerPoint. 

To do this Press 

Make selected text bold. Ctrl+B 

Change the font size for selected 
text. 

Alt+H, F, and 
then S 

Change the zoom for the slide. Alt+W, Q 

Cut selected text, object, or slide. Ctrl+X 

Copy selected text, object, or slide. Ctrl+C 

Paste cut or copied text, object, or 
slide. 

Ctrl+V 

Undo the last action. Ctrl+Z 

Save the presentation. Ctrl+S 

Insert a picture. Alt+N, P 

Insert a shape. Alt+H, S, and then 
H 

Select a theme. Alt+G, H 

Select a slide layout. Alt+H, L 

Go to the next slide. Page Down 

Go to the previous slide. Page Up 

Go to the Home tab. Alt+H 

Move to the Insert tab. Alt+N 

Start the slide show. Alt+S,B 

End the slide show. Esc 

Close PowerPoint. Alt+F, X 

 
MS EXCEL 2016 
Microsoft Excel is a spreadsheet developed by Microsoft. 
Spreadsheets allow you to keep track of data, create charts 
based from data, and perform complex calculations. Just like a 
book ledger, spreadsheets store information in columns and 
rows. You can have up to 256 columns and 65,536 rows per 
worksheet.  
 

Feature Maximum limit 

Worksheet size 
1,048,576 rows by 16,384 
columns 

Column width 255 characters 

Row height 409 points 

Page breaks 1,026 horizontal and vertical 

Total number of 
characters that a cell 
can contain 

32,767 characters 

Characters in a 
header or footer 

255 

Maximum number of 
line feeds per cell 

253 

Sheets in a workbook 
Limited by available memory 
(default is 1 sheet) 

Unique cell 
formats/cell styles 

64,000 

Feature Maximum limit 

Unique font types 
1,024 global fonts available 
for use; 512 per workbook 

Hyperlinks in a 
worksheet 

66,530 hyperlinks 

Panes in a window 4 

Zoom range 10 percent to 400 percent 

Fields in a data form 32 

 
Workbook and Worksheet 
 
An Excel worksheet is a single spreadsheet that contains cells 
organized by rows and columns. A worksheet begins with row 
number 1 and column A. Each cell can contain a number, text 
or formula. Excel Workbook comprises number of 
worksheets. Many new sheets can be added to a workbook 
using adding worksheet command which is present at the 
bottom. 
 
Formula and Function 
 
Formulas enable you to enter calculations in a worksheet. 
Using Excel for calculations gives you the ability to change the 
data (or values) of the cells, and have the program 
automatically update the recalculate the value of the output 
based on the new numbers. 
 
Here are some most frequently used functions in Excel: 

Function Description 
SUM function Use this function to add the values in 

cells. 
IF function Use this function to return one value if a 

condition is true and another value if it's 
false.  

LOOKUP 
function 

Use this function when you need to look 
in a single row or column and find a 
value from the same position in a second 
row or column. 

MATCH 
function 

Use this function to search for an item in 
a range of cells, and then return the 
relative position of that item in the 
range. For example, if the range A1:A3 
contains the values 5, 7, and 38, then the 
formula =MATCH(7,A1:A3,0) returns 
the number 2, because 7 is the second 
item in the range. 

CHOOSE 
function 

Use this function to select one of up to 
254 values based on the index number. 
For example, if value1 through value7 
are the days of the week, CHOOSE 
returns one of the days when a number 
between 1 and 7 is used as index_num. 

DATE 
function 

Use this function to return the 
sequential serial number that 
represents a particular date. This 
function is most useful in situations 
where the year, month, and day are 
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supplied by formulas or cell references. 
For example, you might have a 
worksheet that contains dates in a 
format that Excel does not recognize, 
such as YYYYMMDD. 
Use the DATEDIF function to calculate 
the number of days, months, or years 
between two dates. 

DAYS 
function 

Use this function to return the number of 
days between two dates. 

FIND, FINDB 
functions 

FIND and FINDB locate one text string 
within a second text string. They return 
the number of the starting position of 
the first text string from the first 
character of the second text string. 

 
 

Freeze Panes in Excel 
If you wish to see a particular area of a worksheet visible or 
multiple rows and columns while you scroll to another area 
of the worksheet, you can use Freeze Panes (available under 
view tab). 
 
Tabs in MS Excel 2016 

The ribbon in Excel and other Office Suite’s Application has 

Tabs. In Excel 2016 there are 8 tabs followed by a new 

feature of “Tell me what you want to do” arranged in a 

horizontal fashion. The tabs are as follows: File, Home, Insert, 

Page Layout, Formulas, Data, Review, and View. 

Following are the groups of Commands available under tabs 

of Excel 2016: 

Home: Clipboard, Font, Alignment, Number, Style (for 

Conditional Formatting of table), Cells (to insert, delete and 

format cells), Editing (AutoSum, Sort & Filter, Find & Select) 

Insert: Tables (Pivot Table, and Tables); Illustrations 

(Pictures, Online Picture, shapes and Icon); Add-ins; Charts; 

Tours (3D Map); Sparklines (Line, Column, Win/Loss); 

Filters; Links; Text; Symbols 

Page Layout: Themes; Page Setup (Margin, orientation, page 

size, print area, breaks, background and print titles); Scale to 

fit; Sheet Options (Gridline, headings); Arrange 

Formulas: Insert Function; Function Library; Defined 

Names; Formula Auditing; Calculation 

Data: Get external Data; Get & Transform (New query, show 

queries, from table, recent sources); Connections; Sort and 

Filter; Data Tools; Forecast (what-if analysis, forecast sheet); 

Outline 

Review: Proofing (Spelling, Thesaurus); Accessibility; 

Insights-smart lookup; Comments; Changes (Protect sheet, 

protect workbook, share workbook, allow users to edit 

ranges, track changes) 

View: Workbook Views (Normal, Page Break Preview, Page 
Layout, Custom Views); Show (gridlines, ruler. formula bar, 
headings); Zoom; Window; Macros 

EXCEL 2016 SHORT CUT KEYS 
 
Frequently used shortcuts Keys 
 

To do this Press 

Close a spreadsheet Ctrl+W 

Open a spreadsheet Ctrl+O 

Go to the Home tab Alt+H 

Save a spreadsheet Ctrl+S 

Copy Ctrl+C 

Paste Ctrl+V 

Undo Ctrl+Z 

Remove cell contents Delete key 

Choose a fill color Alt+H, H 

Cut Ctrl+X 

Go to Insert tab Alt+N 

Bold Ctrl+B 

Center align cell contents Alt+H, A, then C 

Go to Page Layout tab Alt+P 

Go to Data tab Alt+A 

Go to View tab Alt+W 

Open context menu Shift+F10, or 
Context key 

Add borders Alt+H, B 

Delete column Alt+H,D, then C 

Go to Formula tab Alt+M 

Hide the selected rows Ctrl+9 

Hide the selected columns Ctrl+0 

Format in cells: keyboard shortcuts 
 

To do this Press 
Move to the previous cell in a 
worksheet or the previous option 
in a dialog box. 

Shift+Tab 

Move one cell up in a worksheet. Up Arrow key 
Move one cell down in a 
worksheet. 

Down Arrow 
key 

Move one cell left in a worksheet. Left Arrow key 
Move one cell right in a 
worksheet. 

Right Arrow 
key 

Move to the edge of the current 
data region in a worksheet. 

Ctrl+arrow key 

Enter End mode, move to the next 
nonblank cell in the same column 
or row as the active cell, and turn 
off End mode. If the cells are 
blank, move to the last cell in the 
row or column. 

End, arrow key 

Move to the last cell on a 
worksheet, to the lowest used 
row of the rightmost used 
column. 

Ctrl+End 
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Extend the selection of cells to the 
last used cell on the worksheet 
(lower-right corner). 

Ctrl+Shift+End 

Move to the cell in the upper-left 
corner of the window when Scroll 
Lock is turned on. 

Home+Scroll 
Lock 

Move to the beginning of a 
worksheet. 

Ctrl+Home 

Move one screen down in a 
worksheet. 

Page Down 

Move to the next sheet in a 
workbook. 

Ctrl+Page 
Down 

Move one screen to the right in a 
worksheet. 

Alt+Page Down 

Move one screen up in a 
worksheet. 

Page Up 

Move one screen to the left in a 
worksheet. 

Alt+Page Up 

Move to the previous sheet in a 
workbook. 

Ctrl+Page Up 

Move one cell to the right in a 
worksheet. Or, in a protected 
worksheet, move between 
unlocked cells. 

Tab 

 
Format in cells: keyboard shortcuts 

To do this Press 

Open the Format Cells dialog box. Ctrl+1 

Format fonts in the Format Cells 
dialog box. 

Ctrl+Shift+F or 
Ctrl+Shift+P 

Edit the active cell and put the 
insertion point at the end of its 
contents. Or, if editing is turned off 
for the cell, move the insertion 
point into the formula bar. If 
editing a formula, toggle Point 
mode off or on so you can use 
arrow keys to create a reference. 

F2 

Add or edit a cell comment. Shift+F2 

Open the Insert dialog to insert 
blank cells. 

Ctrl+Shift+Plus 
(+) 

Open the Delete dialog box to 
delete selected cells. 

Ctrl+Minus (-) 

Enter the current time. 
Ctrl+Shift+colo
n (:) 

Enter the current date. 
Ctrl+semi-
colon (;) 

Switch between displaying cell 
values or formulas in the 
worksheet. 

Ctrl+grave 
accent (`) 

Copy a formula from the cell above 
the active cell into the cell or the 
Formula Bar. 

Ctrl+apostroph
e (') 

Move the selected cells. Ctrl+X 

Copy the selected cells. Ctrl+C 

To do this Press 

Paste content at the insertion 
point, replacing any selection. 

Ctrl+V 

Open the Paste Special dialog box. Ctrl+Alt+V 

Italicize text or remove italic 
formatting. 

Ctrl+I or Ctrl+3 

Bold text or remove bold 
formatting. 

Ctrl+B or 
Ctrl+2 

Underline text or remove 
underline. 

Ctrl+U or 
Ctrl+4 

Apply or remove strikethrough 
formatting. 

Ctrl+5 

Switch between hiding objects, 
displaying objects, and displaying 
placeholders for objects. 

Ctrl+6 

Apply an outline border to the 
selected cells. 

Ctrl+Shift+amp
ersand (&) 

Remove the outline border from 
the selected cells. 

Ctrl+Shift+und
erline (_) 

Display or hide the outline 
symbols. 

Ctrl+8 

 
Work with data, functions, and the formula bar: keyboard 
shortcuts 
 

To do this Press 

Select an entire PivotTable 
report. 

Ctrl + Shift + 
asterisk (*) 

Edit the active cell and put the 
insertion point at the end of its 
contents. Or, if editing is turned 
off for the cell, move the 
insertion point into the formula 
bar. If editing a formula, toggle 
Point mode off or on so you can 
use arrow keys to create a 
reference. 

F2 

Expand or collapse the formula 
bar. 

Ctrl+Shift+U 

Cancel an entry in the cell or 
Formula Bar. 

Esc 

Complete an entry in the 
formula bar and select the cell 
below. 

Enter 

Move the cursor to the end of the 
text when in the formula bar. 

Ctrl+End 

Select all text in the formula bar 
from the cursor position to the 
end. 

Ctrl+Shift+End 

Calculate all worksheets in all 
open workbooks. 

F9 

Calculate the active worksheet. Shift+F9 

Display the Function Arguments 
dialog box when the insertion 
point is to the right of a function 
name in a formula. 

Ctrl+A 
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Insert argument names and 

parentheses when the insertion 

point is to the right of a function 

name in a formula. 

Ctrl+Shift+A 

Invoke Flash Fill to 

automatically recognize 

patterns in adjacent columns 

and fill the current column 

Ctrl+E 

Cycle through all combinations 

of absolute and relative 

references in a formula if a cell 

reference or range is selected. 

F4 

Insert a function. Shift+F3 

Create a chart of the data in the 

current range in a separate 

Chart sheet. 

F11 

Define a name to use in 

references. 
Alt+M, M, D 

Paste a name from the Paste 

Name dialog box (if names have 

been defined in the workbook. 

F3 

Move to the first field in the next 

record of a data form. 
Enter 

Create, run, edit, or delete a 

macro. 
Alt+F8 

 
 

FILE EXTENSIONS: 
 
Word 

XML file type Extension 
Document .docx 
Macro-enabled document .docm 
Template .dotx 
Macro-enabled template .dotm 

 
Excel 

XML file type Extension 
Workbook .xlsx 
Macro-enabled workbook .xlsm 
Template .xltx 
Macro-enabled template .xltm 
Non-XML binary workbook .xlsb 
Macro-enabled add-in .xlam 

 
 PowerPoint 

XML file type Extension 

Presentation .pptx 

Macro-enabled presentation .pptm 

Template .potx 

Macro-enabled template .potm 

Macro-enabled add-in .ppam 

Show .ppsx 

Macro-enabled show .ppsm 

Slide .sldx 

Macro-enabled slide .sldm 

Office theme .thmx 

 

Database management system 
 
DBMS is the acronym of Data Base Management System. 
DBMS is a collection of interrelated data and a set of programs 
to access this data in a convenient and efficient way. It 
controls the organization, storage, retrieval, security and 
integrity of data in a database. 
 
Types of Database Model: Network Database Model, 
Hierarchical Database model, Relational Database Model and 
Object-Oriented Database Model. 
 
Architecture of DBMS-The generalized architecture of 
DBMS is called ANSI/ SPARC model. The architecture is 
divided into three levels: 
• External view or user view/View Level- It is the 

highest level of data abstraction. This includes only those 
portions of database of concern to a user or Application 
program. Each user has a different external view and it is 
described by means of a scheme called external schema. 

• Conceptual view/Logical Level- All the database 
entities and the relationship among them are included. 
One conceptual view represents the entire database 
called conceptual schema. 

• Internal view/Physical Level- It is the lowest level of 
abstraction, closest to the physical storage method. It 
describes how the data is stored, what is the structure of 
data storage and the method of accessing these data. It is 
represented by internal schema. 

•  
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• Data model: A data model is a plan for building a database. 
The model represents data conceptually, the way the 
user sees it, rather than how computers store it. Data 
models focus on required data elements and 
associations. 

• Entity – Relationship Model 
• Relational Model 
Entity: A thing (animate or inanimate) of independent 
physical or conceptual existence and distinguishable. 
In the University database context, an individual 
student, faculty member, a class room, are entities. 
Attributes: Each entity is described by a set of 
attributes/properties. 
SQL (Structured Query Language) is a database 
computer language designed for the retrieval and 
management of data in relational database. 

Constrains: In SQL, we have the following constraints- 

NOT NULL - Indicates that a column cannot store NULL 
value UNIQUE - Ensures that each row for a column 

must have a unique value 
CHECK - Ensures that the value in a column meets a 
specific condition 
DEFAULT - Specifies a default value for a column 
Primary Key uniquely identifies a record in a table. 

A candidate key is a single field or the least 
combination of fields that uniquely identifies each 
record in the table. 
A foreign key is generally a primary key from one table 
that appears as a field in another. 
DDL: Data Definition Language is used for specifying 
the database schema. It contains commands to create 
tables, alter the structure, delete tables or rename 
tables. E.g. Create DML: Data Manipulation Language is 
used for accessing and manipulating data in a database. 
E.g. Select, Update 
DCL: Data Control Language is used for granting and revoking 
user access on a database. 
 

Full Forms & Abbreviations  
 

TCP Transmission Control Protocol 
FTP File Transfer Protocol 
TFTP Trivial File Transfer Protocol 
SFTP Secure File Transfer Protocol 
SMTP Simple Mail Transfer Protocol 
HTTP Hyper Text Transfer Protocol 
HTTPS Hyper Text Transfer Protocol Secure 
UDP User Datagram Protocol 
ARP Address Resolution Protocol 
Tel Net Telecommunication Networking 
POP3 Post Office Protocol Version3 
BGP Border Gateway Protocol 
P2P Point to Point Protocol 
PPP Peer to Peer Protocol 
IP Internet Protocol 
SNMP Simple Network Management Protocol 
NTP Network Time Protocol 
SIP Session Initiation Protocol 
DHCP Dynamic Host Configuration Protocol 
IMAP4 Internet Message Access Protocol Version 4 
RARP Reverse Address Resolution Protocol 
SSH Secure Shell 
MIME Multipurpose Internet Mail Extension 
SMIME Secure MIME 
ALGOL Algorithmic Language 
ANSI American National Standard Institute 
ATM Asynchronous Transfer Mode 
AS Autonomous System 

BASIC 
Beginners All Purpose Symbolic Instruction 
code 

BIOS Basic input Output System 
BPS bit Per Second 
DNS Domain Name Server 
EDI Electronic Data Interchange 

URL Uniform Resource Locator 
GIF Graphics Interchange Format 

ASCII 
American Standard Code for Information 
Interchange 

ASP Active Server Pages 
BCC Blind Carbon Copy 
CC Carbon copy 
CAD Computer Aided Design 
CDMA Code Division Multiple Access 
GSM Global System for Mobile Communication  
CMOS complem Metal Oxide Semi Conductor 
CMYK Cyan Magenta Yellow Block 
GPS Global Positioning System 
GUI Graphical User Interface 
HDMI High Definition Multimedia Interface 
GIGO Garbage in Garbage Out 
LIFO Last In First Out 
FIFO First In First Out 
PING Packet Internet Gopher 
HDD Hard Disc Drive 
NIC Network Interface Controller/Cord 
HDTV High Definition Television 
ISP Internet Service Provider 
JPEG Joint Picture Expert Group 
LCD Liquid Crystal Display 
LED Light Emitting Diode 
TFT Thin Film Transistor 
CRT Cathode Ray Tube 
MIDI Musical Instrument Digital Interface 
MPEG Moving Picture Expert Group 
PDA Personal Digital Assistants 
PDF Portable Document Format 
ARPANE
T 

Advanced Research Projects Agency Network 
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SQL Structured Query Language 
USB Universal Serial Bus 
VIRUS Vital Information Resource Under Siege 
VOIP Voice Over Internet Protocol 
IVR Interactive Voice Response 
WIFI Wireless fidelity 
WIMAX Worldwide Interoperability for Microwave 

Access 
ADSL Asymmetric Digital Subscriber Line 
API Application Program Interface 
ARP Address Resolution Protocol 
RARP Reverse ARP 
ICANN Internet Corporation of Assign Names & 

Numbers 
DPI Dots Per Inch 
DSL Digital Subscriber Line 
FAT File Allocation Table 
MANET Mobile Ad-Hoc Network 
MIPS Million Instruction Per Second 
BIPS Billion Instruction Per Second 
TIPS Trillion Instruction Per Second 
NAT Network Address Translation 
IEEE Institute of Electrical and Electronic Engineer 
IMAP Internet Message Access Protocol 
ISDN Integrated Servers Digital Network 

ISO 
International Standard Organization 
/ International Org for Standardization 

DHTML Dynamic Hyper Text Markup Language 
MAC Media Access Control 
CAN Campus Area Network 
PAN Personal Area Network 

SAN Storage Area Network 
CNM Circulatory Network Mode 
IPV4 Internet Protocol Version 4 
IPV6 Internet Protocol Version 6 
DBMS Data Base Management System 
MODEM Modulator Demodulator 
RAM Random Access Memory 
ROM Read Only Memory 
SMPS Switch Mode Power Supply 
OMR Optical Mark Reader / Recognition 
OCR Optical Character Reader / Recognition 
BCR Bar Code Reader 
MICR Magnetic Ink Character Reader Recognition 
PCB Printer Circuit Board 
SRAM Static RAM 
DRAM Dynamic RAM 
PROM Programmable ROM 
EPROM Electrically PROM 
EEPRO
M 

Electrically Erasable PROM 

HDD Hard Disc Drive 
FDD Floppy Disc Drive 
CD Compact Disc 
DVD Digital Video/Versatile Disc 
BRD Blu Ray Disc 
HVD Holographic Versatile Disc 
ACID Atomicity Consistency Isolation Durability 
WYSIWY
G 

What you see is what you get 

 

Glossary 
 

A 
• Access time - The amount of time it takes for requested 

information to be delivered from disks and memory. 
• Antivirus software - A program designed to look for and 

destroy viruses that may infect the memory of a computer 
or files stored on a computer. 

• Artificial intelligence (AI) - Computer systems that 
attempt to imitate human processes for analyzing and 
solving problems. 

• Accumulator - A local storage area called a Register, in 
which the result of an arithmetic or logic operation is 
formed. 

B 
• BIT - It is basic unit of computers. It has two values 1 & 0 

only. 
• BYTE - Combination of 8 Bits. 
• Basic Input Output System (BIOS) - Also known as ROM 

BIOS. It provides an abstraction layer for the hardware, 
i.e., a consistent way for application programs and 
operating system to interact with input/output devices. 

• Bug - A software bug is an error, flaw, failure, or fault in a 
computer program or system produces an incorrect or 
unexpected result. 

• Bus - A pathway along which electronic signals travel 
between the components of a computer system. 

C 
• Cookie - A packet of information that travels between a 

browser and the web server. 
• Crash - Your computer or application no longer works 

correctly and so you “loose” all the work you’ve done 
since the last time you saved. 

• Command - An instruction that causes a program or 
computer to perform a function. 

• Cache - It is a memory storage area that keeps frequent 
use data readily available to the computer so that the 
computer does not retrieve them from slow storage 
devices.clock speed. High clock speed is synonymous with 
high processing capability. It is measured in Megahertz 
(MHz). 

• Column - A vertical block of cells in a table or 
spreadsheet. 

D 
• Delete - To remove an item of data from a file or to 

remove a file from the disk. 
• Debugging - Locating and eliminating defects in a 

program. 
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• Desktop - The electronic work area on a display screen. 
• Dots Per Inch (DPI) - It is defined as the measure of the 

resolution of a printer and scanner, or monitor. 
• Domain Name - A unique name that identifies a 

particular website and represents the name of the server 
where the web pages reside. 

E 
• Edit - To make certain changes in existing data. 
• Ethernet Card - A network adapter that enables a 

computer to connect to an Ethernet. 
 

F 
• Fax - A shortened form of the word facsimile. A copy of a 

document transmitted electronically from one machine to 
another. 

• File transfer protocol (FTP) - A set of guidelines or 
standards that establish the format in which files can be 
transmitted from one computer to another. 

• Firewall - A security system usually consisting of 
hardware and software that prevents unauthorized 
persons from accessing certain parts of a program, 
database, or network. 

• Flash Memory - It is a type of non-volatile computer 
storage chip that can be electrically erased and 
reprogrammed. It was developed by EEPROM. 

G 
• Gateway - A machine that links two networks using 

different protocols. 
• Gigabyte - A measurement of the storage capacity of a 

device. One gigabyte represents 1024 megabytes. 
• Google – search engine on the web. 
• Gopher - A protocol used for locating and transferring 

information on the internet. It is an internet search tool 
that allows users to access textual information. 

• GUI - Graphical User Interface uses icons and menus to 
carry out commands such as opening files, delete files, 
move files etc.. 

• Graphic Interchange Format (GIF) - A simple file 
format for pictures and photographs that are compressed 
so that they can be sent quickly. 

H 
• Hard copy - Text or graphics printed on paper; also called 

a printout. 
• Hard disk - A rigid type of magnetic medium that can 

store large amounts of information. 
• Hyperlink - An image or portion of text on a webpage 

which is linked to another webpage. 
• Hub-A network device that connects multiple computers 

on a LAN so that they can communicate with another 
network and the internet. 

• Header - Repetitive information that appears at the top 
(the head) of every page of a document. 

• Hypertext transfer protocol (HTTP) - The protocol used 
on the World Wide Web that permits Web clients (Web 
browsers) to communicate with Web servers 

I 
• Icons-In a graphical user interface (GUI), a small, 

pictorial, on screen representation of an object, such as a 

document, program, folder or disk drive. 
• Instant messaging (IM) - A chat program that lets people 

communicate over the Internet in real time. 
• Internet protocol (IP) address - A unique set of 

numbers that identifies a computer over a network. 
• Internet service provider (ISP) - An organization that 

provides access to the Internet for a fee. 
• Intranet - A private network established by an 

organization for the exclusive use of its employees. 
Firewalls prevent outsiders from gaining access to an 
organization’s intranet 

J 
• JPEG - Joint Photographic Experts Group. A format for 

storing complex graphics in compressed form. 
• Justification - Aligning lines of text at the left margin, the 

right margin, both margins, and the centre. Text aligned 
at both margins is considered fully justified. 

 
K 

• Keyboard - The device used to enter information into a 
computer. 

• Kilobyte - A measurement of the storage capacity of a 
device. One kilobyte represents 1024 bytes. 

 
L 

• LAN - A local area network (LAN) is a computer network 
that interconnects computers within a limited area such 

as a home, school, computer laboratory, or office building, 
using network media. 

• Laptop computer - A portable computer. Also known as a 
notebook computer. 

• Landscape Orientation – The positioning of the page so that 
the information is printed across the long dimension of 
the page. 

• Liveware - It is a term to describe the human system, 
opposed to hardware or software in a computer. 

M 
• Macro virus - A type of virus that attaches itself to 

documents or word processing templates. 
• Malware - Software that disrupts normal computer 

functions or sends a user’s personal data without the 
user’s authorization. 

• Memory - The part of a computer that stores information. 
• Memory Cell - A circuit in memory that represents a 

single bit of information. 
• Mass Storage - Storage systems that provide access to 

hundreds of billions of bytes of stored data. They are often 
referred to as Archival Storage because of the very large 
volumes of historical or backup data they can store. 

• MIPS - An acronym derived from millions of instructions 
per second. Used to measure the speed of a processor. 

• Morphing - The transformation of one image into 
another image. 

• Mobile Commerce (m-Commerce) - A form of e- 
commerce that has the ability to conduct monetary 
transactions via a mobile device such as a cell phone. 

• Mozilla - a web browser and successor to Netscape 
Communicator. 
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• Multitasking - The ability of a computer to execute more 
than one program at a time. 

N 
• NIBBLE - Combination of four bits. 
• Network - A system of interconnected computers. They are 

of three types i. e. LAN, MAN, WAN. 
• Network Interface Card (NIC) - This is a part of the 

computer that allows it to talk to other computers via a 
network protocol like TCP/IP. 

• Node - A computer which is attached to the network. Each 
node has its own address on the network so that it can be 
uniquely identified and can communicate with other 
nodes on the same or different network. 

O 
• Offline - Refers to the state in which a computer is 

temporarily or permanently unable to communicate with 
another computer. 

• Online - Refers to the state in which a computer is ready to 
communicate with other computers. 

• Open source software - Software that makes the 
underlying source code available to all users at no charge. 

• Operating system (OS) - Software that manages the 
internal functions and controls the operations of a 
computer. 

P 
 Palmtop computer - A portable computer smaller than a 
notebook (or laptop) computer that fits on the palm of 
your hand. Also called a handheld computer. 

• Password - A user’s secret identification code, required to 
access stored material. A procedure intended to prevent 
information from being accessed by unauthorized 
persons. 

• Piracy - The illegal copying of software or other creative 
works. 

• Peripherals - A connectable device that has an auxiliary 
function outside the permanent system configuration 
such as plotters, printers and graphic displays. 

• Phishing - A type of computer fraud that tries to trick 
users into revealing their passwords and other 
confidential information. 

• Pixel - A smallest picture element of a digital image. The 
smaller the pixels, the higher the resolution. 

• Port - An electrical connection on the computer into 
which a cable can be plugged so that the computer can 
communicate with other devices such as printer or 
modem. 

• Protocol - A set of rules and regulations that coordinates 
the exchange of information over the network. 

• Portrait orientation - Positioning paper so that 
information is printed across the short dimension of the 
paper. 

Q 
• Query - An alternate pipe form of operating system, 

which handles data in the form of messages rather than 
bytes. 

• Qwerty - It is one of the standard computer keyboard, 
with the character Q, W, E, R, T, Y on the top row of letters 
on the keyboard.  

R 
• Response time - The time a computer takes to execute a 

command. 
• Retrieve - To call up information from memory or 

storage so that it can be processed in some way. 
• Record - A collection of all the information pertaining to a 

particular subject. 
• Row - A horizontal block of cells in a table or spreadsheet. 
• Resolution - Measurement of the degree of sharpness of a 

displayed image. It is defined as number of pixels per 
square inch on a computer generated display. 
Register - A temporary storage unit for quick, direct 
accessibility of a small amount of data for processing. 

S 

• Shut down - To quit all applications and turn off the 
computer. 

• Spam - unwanted repetitious messages, such as 
unsolicited bulk e-mail. 

• Scanner - An input device that can copy a printed page 
into a computer’s memory, thus doing away with the need 
to type the copy. 

• Screen saver - A program that changes the screen display 
while the user is away from the computer. 

• Server - A computer that manages a shared resource and 
provides a set of shared user services to the clients. 

• Search Engine - Software that searches, gathers and 
identifies information from a database based on an index, 
keywords or titles. 

• Spam - Unwanted repetitious messages, such as 
unsolicited bulk e-mail. 

• Soft copy - Information shown on the display screen. 
• Sort - To arrange fields, records, or files in a 

predetermined sequence. 
• Surfing the Net - Browsing through various Web sites on 

the Internet in search of interesting things. 
• Save As – Give the file a name and/or store the file in a 

certain place. 
• Save - Tell the computer to create a file on disk that has the 

information you’ve put into the document. 
• Scroll bar - Allows you to move around through your 

document. 
T 

• Trash - Place where you put files and folders that you 
want to delete or get rid of. 

• Topology - The structure of the network, including 
physical connections such as wiring schemes and logical 
interactions between network devices. 

• Track - A ring on a disk where data can be written. 
 

• Telnet - A protocol for remote computing on the internet 
that allows a computer to act as a remote terminal on 
another machine, anywhere on the internet. 

• Touchpad - The device on a laptop computer that takes the 
place of a mouse. 

• Touch screen technology - The technology that permits a 
user to perform a function simply by touching the screen 
on an appropriate spot. 
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U 
• Uninterrupted Power Supply (UPS) - A Battery 

powered backup system that provides enough electricity 
to a computer during a power outage so that a user can 
save files before shutting down the computer. 

• Universal Serial Bus (USB) - A common standard for 
connecting multiple peripherals to a computer as needed. 

• Upload - To transfer information from a client computer to 
a host computer. 

V 
• Virus - A piece of computer code designed as a prank or 

malicious act to spread from one computer to another by 
attaching itself to other programs. 

W 
• WAP - Wireless Application Protocol is a specification for 

a set of communication protocol used to allow wireless 
devices to access the internet and other utilities. 

• Web browser - Software that permits a user with a click of 
a mouse to locate, display, and download text, video, 

audio, and graphics stored in a host computer on the Web. 
The most common Web browsers now in use are Internet 
xplorer, Google Chrome and Mozilla Firefox. 

• Web site - One or more related pages created by an 
individual or an organization and posted on the World 
Wide Web. 

• Wi-Fi (Wireless fidelity) - A process that permits high- 
speed wireless transmission of data. 

• Word processing - The electronic process of creating, 
formatting, editing, proofreading, and printing 
documents. 

• Workstation - A desktop computer that runs 
applications and serves as an access point in a local area 
network. 

Z 
Zombie - A computer that has been hijacked by a cracker 
without the owner’s knowledge and used to perform 
malicious tasks on the Internet 
 

 

Memory Based Questions of RRB PO/Clerk 2019 
 
Q1. Which of the following operating system developed by 
Apple? 
(a) Windows 10 (b) Android (c) Windows Vista 
(d) macOS (e) None of these 
 
Q2. What is the full form of DBMS? 
(a) Database Maintain System  
(b) Desktop Marketing System  
(c) Database Management System 
(d) Durable Management System  
(e) None of these 
 
Q3. What is the base of Octal Number system? 
(a) 8 (b) 16 (c) 10 
(d) 2 (e) None of these 
 
Q4. Which of the following is used in first generation 
computer? 
(a) Integrated Circuit (b) Vacuum Tube 
(c) Transistor (d) VLSI circuits (e) None of these 
 
Q5. PROM Stands for_______. 
(a) Programmable random-on memory 
(b) Picture random memory 
(c) Process read-only memory 
(d) Programmable read-only memory 
(e) None of these 
 
Q6. COBOL is used for which of the following purpose? 
(a) Scientific calculation 
(b) Business and Finance 
(c) Application development 
(d) Network Security 
(e) None of these 
 

Q7. Which key is used to delete characters to the left of the 
cursor? 
(a) Tab (b) Page Down (c) Delete 
(d) Backspace (e) None of these 
 
Q8. How many MB is equal to 1 GB? 
(a) 10MB (b) 100000MB (c) 20000 MB 
(d) 1024 MB (e) None of these 
 

 
Q9. Convert Binary number (111001)2 to decimal 
number________. 
(a) (38)10 (b) (57)10 (c) (55)10 
(d) (47)10 (e) None of these 
 
Q10. ENIAC belongs to which computer generation? 
(a) Second (b) First (c) Third 
(d) Fourth (e) None of these 
 
Q11. MS Access is a _______? 
(a) System Software (b) Browser (c) Database  
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(d) Pointing Device (e) None of these 
 
Q12. Which of the following is the most common tool used to 
restrict access to a computer system? 
(a) User logins  
(b) Computer keys  
(c) Access-control Software 
(d) Passwords   
(e) None of these 
 
Q13. Photo-editing, spreadsheet and word processing were 
the examples of? 
(a) Application software. (b) System software. 
(c) Operating system software. 
(d) Platform software.  (e) None of these 
 
Q14. Which of the following shortcut key is used to close 
document in MS Word? 
(a)Ctrl+C (b)Alt+W (c) Shift+C 
(d) Ctrl+W (e) None of these 
 
Q15. What is the base of Hexadecimal number system? 
(a) 2 (b) 16 (c) 8 
(d) 10 (e) None of these 
 
Q16.In second generation, which type of memory was used to 
store data?  
(a) Paper tapes  (b) Magnetic drum  (c) Magnetic core  
(d) Magnetic tape  (e) None of these 
 
Q17.Which among the following key can be used as a shortcut 
to rename a folder in Microsoft Windows 8 and higher 
versions? 
(a) F2 (b) F4 (c) F6 
(d) F9 (e) F11 
 
Q18. In order to move from one worksheet to another in MS-
Excel workbook. One should click ___________. 
(a) active cell (b) scroll bar (c) sheet tab 
(d) tab button (e) None of these 
 
Q19.Which shortcut key is used to check spelling and 
grammar in MS-Word? 
(a) F1 (b) F2 (c) F7 
(d) F9 (e) F10 
 
Q20.Which is not a storage device? 
(a) Printer  (b) CD (c) Hard disk  
(d) Floppy Disk (e) DVD 
 
Q21. An image editing software in which we can draw and edit 
images is? 
(a) PageMaker  (b) MS-Paint (c) Coral Draw  
(d) Photo Image (e) Front page 
 
Q22. Which of the following can be used to select the entire 
document? 
(a) Ctrl+A  (b) Alt+F5 (c) Shift+A  
(d) Ctrl+K (e) Ctrl+H 
 

Q23. Which of the following shortcut key is used to minimize 
all open windows and display the desktop? 
(a) Windows logo+D (b) Alt+Shift+C (c) Ctrl+fn 
(d) Tab+Shift+C (e) None of these 
 
Q24.Which of the following kind of devices allows the user to 
add components and capabilities to a computer system? 
(a) System boards  (b) Storage devices (c) Input devices 
(d) Output devices (e) Expansion slots 
 
Q25.Transformation of input into output is performed by: 
(a) Peripherals  (b) Memory  (c) Storage  
(d) ALU (e) CPU 
 
Q26.Which of the following device enabling data transfer 
between two different networks? 
(a) Plotter  (b) Joystick (c) Gateway  
(d) Path (e) None of these 
 
Q27. Among the following which is the popular DOS based 
spreadsheet package? 
(a) Multiplan (b) Word (c) Smart cell 
(d) Lotus 1-2-3 (e) Excel 
 
Q28.Which of the following is a windows utility program that 
locates and eliminates unnecessary fragments and rearranges 
filed and unused disk space to optimize operations? 
(a) Backup (b) Disk cleanup (c) Disk defragmenter 
(d) Restore (e) None of these 
 
Q29.Which among the following key combination can be used 
to search in Windows Explorer? 
(a) Ctrl+F (b) Ctrl+S (c) Ctrl+G 
(d) Alt+S (e) Alt+P 
 
Q30.What is the technology used to read pencil or pen marks 
on a multiple-choice answer sheet called? 
(a) OMR (b) MICR (c) OCR 
(d) CPU (e) FTP 
 
Q31.Which among the following is a type of error that a 
compiler can check? 
(a) Syntax Error (b) Power Failure 
(c) Network Failure (d) All of the above  
(e) None of the above 
 
Q32.A special, high-speed storage area within the CPU in 
which all data must be represented before it can be processed 
is called _____. 
(a) BIOS (b) Cache (c) RAM 
(d) Register (e) None of these 
 
Q33.In Power Point, the Header & Footer button can be found 
on the Insert tab in what group? 
(a) Illustrations group (b) Object group 
(c) Text group (d) Tables group (e) None of these 
 
Q34.Which of the following is generally used for selecting or 
highlighting?  
(a) Icon  (b) Keyboard  (c) Mouse  
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(d) Floppy Disk  (e) None of these  
 
Q35. __________ ensures secure transfer of data over an 
unsecured network, such as the Internet. 
(a) Antivirus (b) Hacking (c) Cracking  
(d) Spoofing (e) Cryptography 
 
Q36.The ability of an operating system to run more than one 
application at a time is called _________. 
(a) Multi-tasking   
(b) Object-oriented programming  
(c) Multi-user computing   
(d) Real-Time 
(e) None of the above  
 
Q37.The process of checking all the peripheral units by the OS 
during the time of booting is known as_____ 
(a) BIOS (b) POST (c) BUS 

(d) Chkdsk (e) None of these 
 
Q38.A handheld device that allows you to control your 
computer without typing instructions from a keyboard is 
known as_______.  
(a) Tablet  (b) PDA (c) Mouse  
(d) Mike  (e) None of these  
 
Q39.The feature in database language that allows us to access 
certain records in database is called __________. 
(a) Query (b) Forms (c) Reports 
(d) Tables (e) Node  
 
Q40.When you save a Microsoft Access project, what file 
format do you use? 
(a) .adp   (b) .Xml  (c) .mbd   
(d) All of the above  (e) None of the above 
 

 

Solutions: 
 
S1. Ans.(d) 
 
S2. Ans.(c) 
Sol. A database management system (DBMS) is system 
software for creating and managing databases. A DBMS makes 
it possible for end users to create, read, update and delete data 
in a database. 
 
S3. Ans.(a) 
 
S4. Ans.(b) 
 
S5. Ans.(d) 
Sol. PROM or programmable ROM (programmable read-only 
memory) is a computer memory chip that can be programmed 
once after it is created. Once the PROM is programmed, the 
information written is permanent and cannot be erased or 
deleted. 
 
S6. Ans.(b) 
Sol. COBOL (Common Business-Oriented Language) is a high-
level programming language for business applications. 
COBOL was designed for business computer programs in 
industries such as finance and human resources. 
 
S7. Ans.(d) 
 
S8. Ans.(d) 
 
S9. Ans.(b) 
Sol. (111001)2 = 1⋅25+1⋅24+1⋅23+0⋅22+0⋅21+1⋅20 = (57)10 
 
S10. Ans.(b) 
S11. Ans.(c) 
S12. Ans.(d) 
S13. Ans.(a) 
S14. Ans.(d) 

S15.Ans.(b) 
 
S16.Ans.(c) 
Sol. In second generation, magnetic cores were used as 
primary memory and magnetic tape and magnetic disks as 
secondary storage devices.  
 
S17. Ans. (a) 
S18. Ans.(c) 
 
S19. Ans.(c) 
 
S20. Ans.(a) 
 
S21.Ans.(c) 
 
S22. Ans.(a) 
 
S23.Ans.(a) 
 
S24. Ans. (e)  
Sol. Expansion slots allows user to add devices. 
 
S25. Ans.(e) 
Sol. the CPU is the Central Processing Unit of the computer. A 
computer's CPU handles all instructions it receives from 
hardware and software running on the computer. 
 
S26. Ans.(c) 
Sol. A gateway is a network node that connects two networks 
using different protocols together. 
 
S27. Ans.(d) 
Sol. Lotus 1-2-3, developed by Lotus Development 
Corporation, is the most popular spreadsheet package among 
DOS users. 
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S28. Ans.(c) 
Sol. Disk Defragmenter is a utility in Microsoft Windows 
designed to increase access speed by rearranging files stored 
on a disk to occupy contiguous storage locations, a technique 
called defragmentation. 
 
S29. Ans.(a) 
Sol. Ctrl+F is the short cut key combination that can be used 
to search in Windows Explorer. 
 
S30. Ans.(a) 
Sol. Optical Mark Recognition What is the technology used to 
read pencil or pen marks on a multiple-choice answer sheet. 
 
S31. Ans.(a) 
Sol. Syntax Errors - These are invalid code which the compiler 
doesn't understand. The compiler will detect them as it can't 
compile them. 
 
S32. Ans.(d) 
Sol. Register is a special high-speed storage area within the 
CPU where all data must be represented before it can be 
processed. 
 
S33. Ans.(c) 
 
S34. Ans.(c) 
Sol. Generally, we can use mouse for selecting or highlighting 
object.  
 

S35. Ans.(e) 
Sol. In cryptography, data are sent in such a way that they look 
completely different from the original data. Thus, 
cryptography ensures secure transfer of data over an 
unsecured network. 
 
S36. Ans.(a) 
Sol. The ability of an operating system to run more than one 
application at a time is called Multi-tasking. 
 
S37. Ans.(b) 
Sol. POST (Power on Self-Test) is a test the computer must 
complete to verify all hardware is working properly before 
starting the remainder of the boot process. 
 
S38. Ans.(c) 
Sol. A mouse is a handheld device that allows you to control 
your computer without typing the instructions from the 
keyboard. By using a mouse, you can select icons, open 
programs, and select, commands, present in a program by 
moving the pointer.              
 
S39. Ans. (a) 
Sol. Query allows us to access certain records in database. 
 
S40. Ans.(a) 
Sol. An Access project is an Access file (.adp) that provides a 
direct, efficient connection to a Microsoft SQL Server database 
through the OLE DB component architecture. 
 

 

Memory Based Questions RRB PO/Clerk 2018 
 
Q1. Which of the following topologies has the highest 
reliability? 
(a) Star topology (b) Bus topology (c) Ring topology 
(d) Mesh topology (e) None of these 
 
Q2. Which among the following term is used for: 
Unauthorized copying of software to be used for personal gain 
instead of personal backups?  
(a) program thievery (b) data snatching (c) software piracy 
(d) program looting (e) data looting 
 
Q3. EDBIC code can support how many different 
representation of characters? 
(a) 256 (b) 149 (c) 1024 
(d) 64 (e) 16 
 
Q4. The main webpage of a website is also known as ­ 
(a) Contents Page (b) Home Page (c) Introduction Page 
(d) First Page (e) Icebreaker Page 
 
Q5. What is a hyperlink? 
(a) It is a text or image that you can click on to jump to a new 
document/page.  
(b) It is an input type for multimedia files.  

(c) It is a collection or directory of web pages. 
(d) It is the home page of a site.  
(e) None of the above 
 
Q6. What is a technique used to gain unauthorized access to 
computers, whereby the intruder sends messages to a 
computer with an address indicating that the message is 
coming from a trusted host? 
(a) Identity Theft (b) Forging (c) IP Spoofing  
(d) Pharming (e) Phishing 
 
Q7. Portrait and Landscape are: 
(a) Page Orientation (b) page layout (c) page size 
(d) page view (e) none of the above 
 
Q8. Internet access by transmitting digital data over the wires 
of a local telephone network is provided by:  
(a) leased line (b) digital subscriber line  
(c) digital signal line (d) MODEM 
(e) None of the above 
 
Q9. Which of the following network devices is also called a 
concentrator? 
(a) Switch (b) Router (c) Brouter 
(d) Repeater (e) Hub 
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Q10. What type of web technology creates an online 
community where people can make statements and others 
can read and respond to those statements? 
(a) I-Journal     (b) Podcast (c) ASP     
(d) Blog (e) None of the above 
 
Q11. What is the full form of EDI in computer? 
(a) Electronic Data Image  
(b) E-mail Data Interchange  
(c) Electronic Data Interchange 
(d) Electronic digital Interchange  
(e) None of these 
 
Q12. What is the use of "," symbol in Ms EXCEL? 
(a) allows you to make one reference for multiple cells located 
between 2 cells  
(b) is used to separate arguments in Excel spreadsheet 
formulas.  
(c) it is an intersection operator  
(d) For Sum of two cells  
(e) None of these 
 
Q13. Which of the following shortcut key use to close the 
current window? 
(a) Alt+F7 (b) Shift+F4 (c) CRLT+F6 
(d) Alt+F4 (e)None of these 
 
Q14. What are programs such as Microsoft Edge that serve as 
navigable windows into the Web called as? 
(a) Hypertext  (b) Web browsers (c) Internet  
(d) Networks (e) Windows Navigator 
 
Q15. Which among the following is a self-contained step-by- 
step set of operations to be performed? 
(a) System Software   (b) Algorithm  
(c) Network topology  (d) Application software 
(e) Utility software 
Q16. which of the following is an intersection of a row and 

column in a spreadsheet? 
(a) Formula (b) Worksheet (c) Address 

(d) Cell (e) None of these 

 

Q17. which of the following is a set of rules computers use to 
talk to each other? 

(a) Syntax (b) HTML (c) DOS command 

(d) Protocol (e) None of these 
 

Q18. Which of the following topology have a central controller 

or hub? 

(a) Star (b) Mesh (c) Ring 
(d) Bus (e) None of these 

 

Q19. Which shortcut key is used to create a new folder in MS 

Windows? 
(a) Right Click Button+W+Enter  

(b) Ctrl+W+Shift   

(c) Right Click Button+F+Enter 

(d) Right Click Button+Q+Enter  

(e) Ctrl+Shift+N 

 

Q20. The first computers were programmed using which of 
the following language? 

(a) Assembly language  (b) Machine language  

(c) Source code (d) Object code  (e) None of the above 
 

Q21. Which of the following is not example of Utility Software? 

(a) Backup software (b) Antivirus software  

(c) Disk tools (d) Media Players  
(e) All of the above are examples of Utility Software 

 

Q22. Copying a process from memory to disk to allow space 
for other processes is called __________. 

(a) Swapping (b) Deadlock (c) Demand Paging 

(d) Page Fault (e) Cloud Computing 

 
Q23. Which of the following is a translator program used for 

assembly language?  

(a) Complier  (b) Interpreter  (c) Translation  
(d) Translator  (e) Assembler  

 

Q24. What is the technical term for the devices connected in a 

network?  
(a) Hubs  (b) Nodes  (c) Sections  

(d) Attachment units  (e) Access points  

 

Q25. Which of the following is the communication protocol 
that sets the standard used by almost every computer that 

accesses web based information?  

(a) XML (b) DML (c) HTTP 
(d) HTML (e) RIP  

 

Q26. What is the attempt to acquire sensitive information 

such as usernames, passwords, and credit card details (and 
sometimes, indirectly, money) by masquerading as a 

trustworthy entity in an electronic communication? 

(a) Phishing (b) Spoofing (c) Identity theft 
(d) Authentication (e) Spamming 

 

Q27. Communication channel is shared by all the machines on 

the network in: 
(a) broadcast network (b) unicast network 

(c) multicast network  

(d) Internet Protocol Address (e) none of the above 
 

Q28. A(n) __________ converts all the source code into machine 

code, creating an executable file. 

(a) linker (b) assembler (c) compiler 
(d) interpreter (e) None of these 

 

Q29. What is the term that refers to an ad hidden inside 
software that you downloaded from an internet site? 

(a) Spam (b) Cookie (c) Phish 
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(d) Adware (e) None of these 

 

Q30. In PowerPoint, what is the function of Alt+N in 

navigating the ribbon with only the keyboard? 
(a) Open the Transitions tab  

(b) Open the Home tab 

(c) Open the Insert tab 
(d) Open the Review tab  

(e) Open the Tell me box 

 

Q31. Commands at the top of a screen such as File-Edit, 
Format and Tools to operate and change things are 

incorporated in __________________. 

(a) Menu bar (b) Tool bar (c) User friendly 
(d) Word processor (e) None of these 

 

Q32. Specialised program(s) designed to allow particular 

input or output device(s) to communication with the rest of 
the computer system is called _______. 

(a) Computer  (b) Device drivers  (c) Interpreters  

(d) Operating system  (e) None of these  
 

Q33. UDP and TCP are categorized under the ___layer of the 

OSI model. 

(a) Data link (b) Application (c) Network 
(d) Transport (e) Session 

 

Q34. Twisted pair wires are commonly used in? 

(a) Telephones networks  
(b) Cable TV Networks 

(c) Computer networks 

(d) Both (a) and (b)  
(e) None of the above 

 

Q35. Timing and control unit is a part of a(n)______. 

(a) ALU  (b) Processor  (c) Memory  
(d) CMOS  (e) BIOS 

 

Q36. A specialized network device that determines the next 
network point to which it can forward a data packet towards 

the destination of the packet is commonly known as_________. 

(a) bridge  (b) router  (c) switch  

(d) hub  (e) repeater 

 

Q37. A database that spreads information across different 

tables while maintaining links between them is referred to 

as________. 
(a) Relational database   

(b) Rotational database  

(c) Database connection 
(d) Tabular database   

(e) None of these 

 

Q38. What does SNMP stand for? 
(a) Simple Network Mail Protocol 

(b) Single Network Mail Protocol  

(c) Single Network Message Protocol 
(d) Simple Network Management Protocol  

(e) None of these 

 

Q39. What is the common name given to a program written in 
any one of the high-level languages? 

(a) System program  (b) Compiler program   

(c) Object program (d) Source program  (e) Data program 
 

Q40. For predicting the weather which of the following is the 

best solution? 

(a) thin clients  (b) servers  (c) supercomputer 
(d) workstations (e) mini computer 

 

 

Solution 

1. (d); In the mesh topology, each computer is connected to 
the other with a separate physical link in a network. It is most 
reliable topology as the network does not get down in case 
one of the nodes is failed. 
 
2. (c); Software piracy is the illegal copying, distribution, or 
use of software. 
 

3. (a); EBCDIC stands for Extended Binary Coded Decimal 
Interchange Code. EBCDIC is a 8-Bit code with 256 different 
representations of characters. It is mainly used in mainframe 
computers. 
 
4. (b); A home page is the main page or the introductory page 
of a website, typically serving as a table of contents for the site. 
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5. (a); A hyperlink, or simply a link, is a reference to data that 
the reader can directly follow either by clicking, tapping, or 
hovering. Hyperlinks are found in nearly all Web pages, 
allowing users to click their way from page to page. 
 
6. (c); Spoofing: It is a type of scam where an intruder 
attempts to gain unauthorized access to a user’s system or 
information by pretending to be the user. The main purpose 
is to trick the user into releasing sensitive information. 
 
7. (a); Page orientation is the way in which a rectangular page 
is oriented for normal viewing. 
 
8. (b); Digital subscriber line (DSL or digital subscriber loop) 
is a family of technologies that are used to transmit digital 
data over telephone lines. 
 
9. (e); A hub contains several ports for connecting multiple 
computers to form a small network. A simple hub is also called 
a concentrator. 
 
10. (d); A blog is a regularly updated website or web page, 
typically one run by an individual or small group, that is 
written in an informal or conversational style. 
 
11. (c); EDI (Electronic Data Interchange) is the transfer of 
data from one computer system to another by standardized 
message formatting, without the need for human 
intervention. EDI permits multiple companies -- possibly in 
different countries -- to exchange documents electronically. 
 
12. (b); 
13. (d); 
14. (b); 
15. (b); 
 
16. (d); A cell is the intersection between a row and a column 
on a spreadsheet that starts with cell A1. 
 
17. (d); A protocol or communication protocol is a set of rules 
in which computers communicate with each other. 
 
18. (a); Star topology is a network topology where each 
individual piece of a network is attached to a central node 
(often called a hub or switch). 
 
19. (e); Ctrl+Shift+N is also the shortcut key to open new 
incognito mode in chrome web browser. 
 
20. (b); First computers were programmed using machine 
language.  
 
21. (d); Utility software is system software designed to help 
analyze, configure, optimize or maintain a computer. 
 
22. (a); Swapping concept comes in terms of process 
scheduling. Scheduler removes process from CPU for duration 
and reduces the degree of multiprogramming. And after some 

time these process can again be reintroduced into main 
memory. 
 
23. (e); Assembler translates a program written in an 
assembly language into machine language.  
 
24. (b); In a computer network, the devices are called nodes. 
 
25. (c); The Hypertext Transfer Protocol (HTTP) is an 
application protocol for distributed, collaborative, 
hypermedia information systems. HTTP is the foundation of 
data communication for the World Wide Web. 
 
26. (a); Phishing is typically carried out by e-mail spoofing or 
instant messaging, and it often directs users to enter details at 
a fake website whose look and feel are almost identical to the 
legitimate one. 
 
27. (a); Broadcast networks: It has a single communication 
channel that is shared by all the machines on the network. 
Short messages, called packets in certain contexts, sent by any 
machine are received by all the others. 
 
28. (c); A compiler converts all the source code into machine 
code, creating an executable file. 
 
29. (d); Adware is software that automatically displays or 
downloads advertising material such as banners or pop-ups 
when a user is online. 
 
30. (c) 
 
31. (a); Those commands, options are available in menu bar. 
 
32. (b); A device driver is a program that controls a particular 
type of device that is attached to your computer. There are 
device drivers for printers, displays, CD-ROM readers, 
diskette drives, and so on. When you buy an operating system, 
many device drivers are built into the product 
 
33. (d); The transport layer is a conceptual division of 
methods in the layered architecture of protocols in the 
network stack in the Internet Protocol Suite and the Open 
Systems Interconnection (OSI). The protocols of the layer 
provide host-to-host communication services for applications 
 
34. (a); Twisted pair wires are used  in telephone networks 
and for digital data transmission over short distances up to 1 
km. 
 
35. (b); Timing and control unit is a part of processor. 
 
36. (b); A router is a networking device that forwards data 
packets between computer networks. Routers perform the 
traffic directing functions on the Internet. 
 
37. (a); A relational database is a collective set of multiple data 
sets organized by tables, records and columns. It establishes a 
well-defined relationship between database tables. 
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38. (d); Simple Network Management Protocol (SNMP) is a 
popular protocol for network management. It is used for 
collecting information from, and configuring, network 
devices, such as servers, printers, hubs, switches, and routers 
on an Internet Protocol (IP) network. 

39. (d); Source program is written in high level language. 
 
40. (c); Supercomputer is used for predicting the weather 
 

Important Questions Based on Microsoft Office 
 
Q1.Microsoft Office is a __________. 
(a)Shareware  
(b) Public-domain software  
(c) Open source software 
(d) An application suit  
(e) Firmware 
 
Q2.Which term is not related with font? 
(a)Font face (b) Font size (c) Font color 
(d) Font grammar (e) None of these 
 
Q3.The valid format of MS Word is __________. 
(a).jpeg (b) .png (c) .doc 
(d) .exe (e) None of these 
 
Q4.Which of the following option may be used to change page-size 
and margins? 
(a)Page Layout (b) View (c) Tools 
(d) Data (e) None of these 
 
Q5.To justify the selected text, the shortcut key is 
__________. 
(a)Ctrl + 1 (b) Ctrl + J (c) Ctrl + U 
(d) Ctrl + Alt + K (e) None of these 
 
Q6.Workbook is a collection of __________ in MS Excel? 
(a)page set-up (b) buttons (c) diagrams 
(d) charts (e) worksheets 
 
Q7.In order to move from one worksheet to another in MS-Excel 
workbook. One should click ___________. 
(a)active cell (b) scroll bar (c) sheet tab 
(d) tab button (e) None of these 
 
Q8.In a spreadsheet, a __________ is a number you will use in a calculation. 
(a)label (b) cell (c) field 
(d) value (e) None of these 
 
Q9.In Power Point, which of the following will not advance the 
slides in a slide show view? 
(a)Esc key (b) The spacebar (c) The Enter key 
(d) The mouse button (e) None of these 
 
Q10.In Microsoft PowerPoint, two kinds of sound effects files that 
can be added to the presentation are 
(a).wav files and .mid files  
(b)wav files and .gif files  
(c) wav files and .jpg files 
(d) jpg files and .gif files 
(e) None of these 

Q11.Which PowerPoint view displays each slide of the 
presentation as a thumbnail and is useful for rearranging 
slides? 
(a)Slide Sorter (b) Slide Show (c) Slide Master 
(d) Notes Page (e) Slide Design 
 
Q12.If you want to insert a chart to your slide then go to__________. 
(a)Insert – Chart (b) Home – Chart C) Format – Chart 
(d) Table – Chart (e) None of these 
 
Q13.Which of the following is not a type of Microsoft access 
database object? 
(a)Table (b) Worksheets (c) Modules 
(d) Macros (e) None of these 
 
Q14.Row in an Access table is also known as __________. 
(a)field (b) record (c) data 
(d) type (e) None of these 
 
Q15.Queries in Access can be used as __________. 
(a)View, change and analyse data in different ways  
(b)A source of records for forms and reports  
(c)to access internet  (d) Both a and b  
(e) None of these 
 
Q16.Pressing F8 key for three times selects 
(a)A word (b) A sentence  (c)  A paragraph 
(d) Entire document  (e) None of these 
 
Q17.What happens if you press Ctrl + Shift + F8? 
(a)It activates extended selection  
(b)It activates the rectangular selection  
(c)It selects the paragraph on which the insertion line is. 
(d)Both (A) and (C)    
(e) None of these 
 
Q18.How can you disable extended selection mode? 
(a)Press F8 again to disable  
(b)Press Del to disable  
(c) Press Esc to disable 
(d) Press Enter to disable  
(e) It cannot be disables 
 
Q19.What does EXT indicator on status bar of MS Word indicate? 
(a)It indicates whether the external text is pasted on 
document or not  
(b)It indicates whether extended add-ons are installed on MS 
Word or not  
(c)It indicates whether Extended Selection mode is turned on 
or off 
(d)Both (A) and (B)  
(e) None of these 
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Q20.What is the maximum number of lines you can set for a drop 
cap? 
(a) 3 (b) 10 (c) 15 
(d) 20 (e) 50 
 
Q21.What is the default number of lines to drop for drop cap? 
(a) 3 (b) 10 (c) 15 
(d) 20 (e)7 
 
Q22.What is the shortcut key you can press to create a copyright 
symbol? 
(a)Alt+Ctrl+C (b) Alt + C (c) Ctrl + C 
(d) Ctrl + Shift + C (e)None of these 
 
Q23.How many columns can you insert in a word document in 
maximum? 
(a) 35 (b)63 (c) 55 
(d) 65 (e) 60 
 
Q24.What is the smallest and largest font size available in Font Size 
tool on formatting toolbar? 
(a)8 and 72 (b) 8 and 64 (c) 12 and 72 
(d) 10 and 40 (e) None of these 
 
Q25.Select all the text in MS Word document by: 
(a)Ctrl + S (b) Ctrl + 1 (c) Shift + A 
(d) Ctrl + A (e) None of these 
 
Q26.MS Word is __________ software. 
(a)System (b) Application  (c) Programming 
(d) Compiler (e) None of these 
 
Q27.The shortcut key for paste selected text/picture in MS Word 
is __________. 
(a)Ctrl + X (b) Ctrl + C (c) Ctrl + V 
(d) Ctrl + Z (e) None of these 
 
Q28.Using Print Preview is useful. When you want to 
(a)colour the document  
(b) save the document  
(c) delete the document 
(d) copy the document  
(e) view how the document will appear when printed 
 
Q29.To indent the first paragraph of your report, you should 
use this key. 
(a)Space bar (b) Return key (c) Tab key 
(d) Shift key (e) None of these 
 
Q30.In Excel, the contents of the active cell are displayed in the 
________. 
(a)footer bar (b) tool bar (c) task bar 
(d) menu bar (e) formula bar 
 
Q31.__________ appear at the bottom of the Excel Window. 
(a)Work sheet tabs  (b) Name box (c) Formula bar 
(d) Title bar (e) None of these 
 
Q32.In MS excel ________ are numbered from 1 to onwards and __________ 
are numbered from A to onwards. 

(a)Columns, rows (b) Rows, slides C) Slides, rows 
(d) Rows, columns  (e) None of these 
 
Q33.What is the default column width of MS Excel? 
(a) 5.5 (b) 2.98 (c) 8.43 
(d) 6.49 (e) None of these 
 
Q34.To insert a new slide go to __________ tab, in the Slides group, click 
New Slide. 
(a)Home (b) View (c) Animations 
(d) Slide show (e) None of these 
 
Q35.Times new Roman, Cambria, Arial are the example of__________. 
(a)Font face (b) Themes (c) SmartArt 
(d) Clipart (e) None of these 
 
Q36.In Access a __________ is the collection of data items of all the fields 
pertaining to one entity. 
(a)field (b) record (c) form 
(d) report (e) None of these 
 
Q37.A table of how many columns can you insert in a word 
document in maximum. 
(a) 55 (b) 42 (c) 32 
(d) 63 (e) As you wish 
 
Q38.In MS Access a __________ name must be unique within a database. 
(a)Field (b) Record (c) Table 
(d) Character (e) None of these 
 
Q39.The minimum number of rows and columns in MS Word 
document is 
(a)1 and 1 (b) 2 and 1 (c) 2 and 2 
(d) 3 and 3 (e) None of these 
 
Q40.Thesaurus tool in MS Word is used for 
(a)Spelling suggestions  
(b) Grammar options  
(c)Synonyms and Antonyms words 
(d)All of the above   
(e) None of these 
 
Q41.Why Drop Caps are used in document? 
(a)To drop all the capital letters  
(b)To automatically begin each paragraph with capital letter 
(c)To begin a paragraph with a large dropped initial capital 
letter 
(d)To drop the numbers  
(e) None of these 
 
Q42.A bookmark is an item or location in document that you 
identify as a name for future reference. Which of the following task 
is accomplished by using bookmarks? 
(a)To add anchors in web page  
(b)To mark the ending of a paragraph of document  
(c)To quickly jump to specific location in document 
(d)To add hyperlinks in webpage  
(e)None of these 
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Q43.A word processor would most likely be used to do 
(a)Keep an account of money spent  
(b)Do a computer search in media center  
(c)Maintain an inventory 
(d)Type a biography  
(e)Maintain records of database 
 
Q44.Which of the following is not valid version of MS Office? 
(a)Office XP (b) Office Vista  (c) Office 2007 
(d) Office 2010 (e) None of these 
 
Q45.You cannot close MS Word application by 
(a)Choosing File menu then Exit submenu  
(b)Press Alt+F4 (c)Click X button on title bar 
(d)From File menu choose Close submenu (e)None of these 
 
Q46.The key F12 in MS Word opens a 
(a)Save As dialog box (b) Open dialog box (c) Save dialog box 
(d) Close dialog box (e) Opens help menu 
 
Q47.What is the short cut key to open the Open dialog box? 
(a)F12 (b) Shift F12 (c) Alt + F1 
(d) Ctrl + F12 (e) None of these 
 
Q48. Suppose you wanted to create an AutoCorrect entry that 
would type the words ‘We regret to inform you that your 
submission has been declined’ of the following choices, which 
would be the best name you could assign to this entry? 
connection from one slide to another slide in the same 
presentation or to a slide in another presentation, an e-mail 
address, a Web page, or a file. 
(a) Hyphenation (b) Header (c) Footer 
(d)Hyperlink (e) None of these 
 
Q49.If you want to convert a symbol or several lines of text into 
an AutoCorrect entry, you should: 
(a)Insert the symbol or type the text in a Word document 
first. Then, select the text or symbol and go to the 
AutoCorrect dialog box.  
(b)Click the Tools menu and choose AutoCorrect Options. 
Then, click the Insert menu and choose Symbol (or click the 
Format menu and choose Paragraph) to add the symbol or 
paragraph to AutoCorrect.  
(c)AutoCorrect can only accommodate one line of text. It is not 
possible to convert a symbol or multiple lines of text into an 
AutoCorrect entry. 
(d)Insert the symbol or type the text in a Word document first. 
Then, select the text or symbol and click the Edit menu 
followed by Paste Special. Select New AutoCorrect Entry and 
then click OK.  
(e)None of the above 
 
Q50.AutoCorrect was originally designed to replace_________ 
words as you type. 
(a)Short, repetitive (b) Grammatically incorrect  
(c) Misspelled words (d) Incorrect Image  
(e) None of the above 

Q51.Which of the following is the second step in creating a macro? 
(a)Start recording  
(b)Using your mouse or keyboard, perform the task you want 
to automate  
(c)Assign a keyboard shortcut to the macro 
(d)Give the macro a name  
(e)None of these 
 
Q52.If you will be displaying or printing your document on another 
computer, you’ll want to make sure and select the _____________ option 
under the ‘Save’ tab. 
(a)Embed Fonts  
(b) Embed True Type Fonts  
(c) Save True Type Fonts D) Save Fonts (e) Font Face 
 
Q53.In Word, the mailing list is known as the ____________. 
(a)Data sheet (b) Source (c) Data source 
(d) Sheet (e) Hyperlink 
 
Q54.To delete 3-D rotation from the shape, point to 3-D Rotation, 
and then click _____. 
(a)Non Rotation  (b) Not Rotation  (c) None Rotation 
(d) No Rotation (e) None of these 
 
Q55.In Microsoft Office Power-Point 2007, a_____ is a connection 
from one slide to another slide in the same presentation or to a 
slide in another presentation, an e-mail address, a Web page, or 
a file. 
(a) Unassigned  
(b)Located on the ten-key pad section of your keyboard.  
(c)Assigned to another task. 
(d)From the same font family as the symbol.  
(e)None of these 
 
Q56.In PowerPoint, which of the following is the default page 
setup orientation for notes pages, outlines and handouts? 
(a)Vertical (b) Landscape (c) Portrait 
(d) All of these (e) None of these 
 
Q57.In slide layout panel, how many layouts are available for next 
layout by default? 
(a) 4 (b) 7 (c) 12 
(d) 15 (e) None of these 
 
Q58.In Access, this operation copies a backup file from the storage 
medium back onto the computer : 
(a)Restore (b) Recreate (c) Copy 
(d) Structure (e) None of these 
 
Q59.In the Form Wizard dialog box, the fields from the selected 
table are displayed in which list box? 
(a)All fields (b) All Records  
(c) Available Records  (d) Available Fields  
(e) None of these 
 
Q60.Which control does access use to link data access page 
components to access data? 
(a)Microsoft Office Data Source Control  
(b)Microsoft Dynamic Data Control  
(c)Microsoft Data Connection Control 
(d)Microsoft Default Connection Control  
(e) None of the above 
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Computer Knowledge Practice Set 
 
Q1.Which among the following key combination can be used 
to search in Windows Explorer? 
(a) Ctrl+F (b) Ctrl+S (c) Ctrl+G 
(d) Alt+S (e) None of the above 
 
Q2.Which among the following is an important circuitry in a 
computer system that does the arithmetic and logical 
processing? 
(a) Memory (b) ALU (c) Flag Register 
(d) CU (e) Calculator 
 
Q3.What is the full form of DTP in Computers? 
(a) Desktop Product (b) Dynamic Technology Product 
(c) Desktop Publishing (d) Desktop Phishing  
(e) None of these 
 
Q4.The coding language used to create documents for use on 
the Internet is __________. 
(a) HTML (b) HSMT (c) HLTM 
(d) All of these (e) None of these 
 
Q5.Which of the following is not a type of database? 
(a) Hierarchical (b) Relational (c) Network 
(d) Transition (e) None of the above 
 
Q6.If you wish to extend the length of the network without 
having the signal degrade, you would use a _____. 
(a) Repeater (b) Router (c) Gateway 
(d) Switch (e) None of these 
 
Q7.Java was introduced by which among the following 
organisation? 
(a) Sun Microsystem (b) IBM (c) Intel 
(d) Microsoft (e) AT & T 
 
Q8.What type of web technology creates an online 
community where people can make statements and others 
can read and respond to those statements? 
(a) I-Journal (b) Podcast (c) ASP 
(d) Blog (e) None of the above 
 
Q9.What is the full form of SIM? 
(a) Station Identity Module  
(b) System Identity Module  
(c) Subscriber Identity Module 
(d) Subscriber Trunk Dialling  
(e) None of these 
 
Q10.What type of technology allows you to verbally speak 
with someone over the Internet? 
(a) Wiki (b) Social network (c) E-phone 
(d) VoIP (e) None of these 
 
Q11.Which of the following describe router functions? 
(a) Packet switching (b) Packet filtering 
(c) Internetwork communication 
(d) Path selection  (e) All of the above 

Q12.What is periodically adding, changing and deleting file 
records called? 
(a) renewing (b) upgrading (c) restructuring 
(d) updating (e) None of these 
 
Q13._______ are specially designed computer chips that reside 
other devices. Such as your car or your car or your electronic 
thermostat. 
(a) Severs (b) Embedded computers  
(c) Robotic Computers (d) Mainframe (e) None of these 
 
Q14.A string of eight 0s and 1s is called a: 
(a) Megabyte (b) Kilobyte (c) Gigabyte 
(d) Byte (e) None of these 
 
Q15. There are ______ unique digits available in Hexadecimal 
number system. 
(a) 16 (b) 17 (c) 18 
(d) 19 (e) 20 
 
Q16.The process of connecting/ accessing to an account is 
called as: 
(a) Login (b) Logout (c) Sign In 
(d) Sign Out (e) None of these 
 
Q17. The first computers were programmed using which of 
the following language. 
(a) Assembly language (b) Machine language 
(c) Source code (d) Object code (e) None of the above 
 
Q18.Which one of the following is a set of one or more 
attributes taken collectively to uniquely identify a record? 
(a) Candidate key (b) Sub key (c) Super key 
(d) Foreign key (e) None of these 
 
Q19.Which of the following is Open Source Software? 
(a) Windows (b) Linux (c) IOS 
(d) Adobe Photoshop (e) None of these 
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Q20.Which among the following operation relates to a set of 
computers connected to a LAN? 
(a) They can process faster  
(b) Main purpose is to go on line  
(c) They can now share information and/or share peripheral 
equipment 
(d) Sole purpose of sending/receiving E-mail  
(e) They can only manage ROM 

 
 
Q21.Graphical pictures that represent an object like file, 
folder etc. are? 
(a) Task bar (b) Windows (c) Desktop 
(d) Icons (e) Control Panel 
 
Q22.Which of the following programming language is used 
for creating special programs like applets? 
(a) Java (b) Cable (c) Domain name 
(d) Net (e) COBOL 
 
Q23.Access control based on a person’s fingerprints is an 
example of _________. 
(a) biometric identification (b) characteristic 
identification (c) fingerprint security 
(d) logistics (e) None of these 
 
Q24.Which is commonly used protocol for exchanging files 
over any network that supports the TCP/IP protocol. 
(a) FTP (b) TCP (c) SMTP 
(d) HTTP (e) None of these 
 
Q25.Which of the following option may be used to change 
page-size and margins? 
(a) Page Layout (b) View (c) Tools 
(d) Data (e) None of these 
 
Q26.What does P2P stands for? 
(a) Peer to Peer (b) Peek to peek (c) Past to past 
(d) Pair to pair (e) All of these 
 
Q27.Which among the following term is used for: 
Unauthorized copying of software to be used for personal 
gain instead of personal backups? 
(a) program thievery (b) data snatching 
(c) software piracy  (d) program looting (e) data looting 
 
Q28.Which of the following extension refers to System files? 
(a) .COM (b) .EXE (c) .SYS 
(d) .PRG (e) None of these 
 
Q29.What is a bootstrap? 
(a) A memory device  
(b) A device to support the computer  
(c) An error correction technique 
(d) A small initialization program to start up a computer  
(e) None of the above 

Q30.The insert, cap lock and num lock are all examples of 
__________ keys. 
(a) Control (b) Function (c) Toggle 
(d) Shortcut (e) None of these 
 
Q31. Speed of line printer is specified in terms of __________. 
(a) Line per minute (b) Character per minute  
(c) Dot per minute (d) All of these (e) None of these 
 
Q32.EPROM is generally erased by using ______. 
(a) ultraviolet rays  (b) infrared rays  
(c) 12V electrical pulse   (d) 24V electrical pulse  
(e) None of these 
 
Q33.What does RDBMS stands for? 
(a) Relational Database Management System  
(b) Relational Data Management System  
(c) Relational Database Management Software 
(d) Relational Data Management Software  
(e) Real Database Management System 
 
Q34.Which of the following is a folder that retains copies of 
messages have started but are not yet send to the recipient? 
(a) Inbox (b) Outbox (c) CC 
(d) Sent Items (e) Drafts 
 
Q35. Which of the following is required to communicate 
between two computers? 
(a) communications software  
(b) communications hardware  
(c) protocol 
(d) access to transmission medium  
(e) All of the above 
 
Q36.Which of the following would most likely not be a 
symptom of a virus? 
(a) Existing program files and icons disappear  
(b) The CD-ROM stops functioning  
(c) The web browser opens to an unusual home page 
(d) Odd message or images are displayed on the screen  
(e) None of these 
 
Q37.Which among the following can control the look of your 
entire presentation including font, color, background, effects 
and everything else? 
(a) Handout Master (b) Slide Master (c) Slide Show 
(d) Thesaurus (e) Icons 
 
Q38.Which of the following software posts unwanted 
advertisements on client’s computer? 
(a) Virus (b) Malware (c) Worm 
(d) Adware (e) Logic bombs 
 
Q39.Which among the following options is the application 
that combines text, sound, graphics, motion video, and/ or 
animation? 
(a) Multimedia (b) Minimedias (c) Videoscapes 
(d) Motionware (e) Maxomedia 
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Q40.FORTRAN is a programming language. It is more 
suitable for _______. 
(a) business applications  
(b) marketing applications  
(c) scientific applications 
(d) statically calculative applications  
(e) None of these 
 
Q41.If a word is typed that is not in MS Word's dictionary, a 
wavy underline appears below the word. What is the color of 
the underline that appears in this situation? 
(a) Blue (b) Red (c) Green 
(d) Black (e) Pink 
 
Q42.Which of the following is a storage device that uses 
rigid, permanently installed magnetic disks to store 
data/information? 
(a) Floppy diskette (b) Hard disk (c) Permanent disk 
(d) Optical disk (e) None of the above 
 
Q43. What is SQL? 
(a) Language used to communicate with database  
(b) Language used for object oriented programming  
(c) Language used to program system software 
(d) Language used to hack into other systems  
(e) Language used for programming devices 
 
Q44. The most widely used type of database management 
system is the: 
(a) Flat database (b) Network database 
(c) Relational database (d) Hierarchical database  
(e) None of the above 
 
Q45. Which among the following is the reboot where the 
power to the system is physically turned off and back on 
again, causing an initial boot of the machine? 
(a) Toggle (b) Cold booting (c) Warm booting 
(d) Logging off (e) None of these 
 
Q46.To protect your system from computer hackers you 
must turn on a(n) _______. 
(a) USP (b) VLC (c) Another system 
(d) Script (e) Firewall 
 
Q47.The point at which the flow of text in a document moves 
to the top of a new page– 
(a) Page insert (b) Page break (c) Page format 
(d) All of the above (e) None of the above 
 
Q48.Which program, installed on the user’s computer help 
him to communicate or send request on the network? 
(a) Paint (b) File Manager (c) Browser 
(d) Word (e) None of the above 
 
Q49.What is an ad hoc query? 
(a) Pre-planned question  
(b) Pre-scheduled question  
(c) Spur-of-the-moment question 
(d) Question that will not return any results  
(e) None of these 
 

Q50.What does DRAM stands for? 
(a) Digital Random Access Memory  
(b) Dynamic Random Access Memory  
(c) Dividing Random Access Memory 
(d) Dynamic Recording Access Memory  
(e) None of these 
 
Q51.Which of the following is true about Assembly language? 
(a) It is an Object-Oriented Programming Language  
(b) It is a High-level programming language  
(c) It is a low-level programming language 
(d) It is a language for assembling computers  
(e) It is latest flash memory language 
 
Q52.In an Excel table, what uses a single formula that adjusts 
for each row? 
(a) Calculated column (b) Formula bar (c) New column 
(d) Array  (e) None of these 
 
Q53.Which of the following is an expansion card which 
generates a feed of output images to a display? 
(a) Bus (b) Motherboard (c) Play station 
(d) Ultra high deficition (e) video card 
 
Q54.Which of the function in Computers is the one that 
control processes and accept data in continuous fashion? 
(a) Data traffic pattern (b) Data highway  
(c) Highway loop (d) Feedback loop (e) All of these 
 
Q55.Which among the following is a special visual and audio 
effect applied in PowerPoint to text or content? 
(a) Animation (b) Flash (c) Wipe 
(d) Dissolve (e) None of these 
 
Q56.Which of the following is a software used for Remote 
Connection? 
(a) TeamViewer (b) Picasa (c) Prisma 
(d) Safari (e) Intel Connect 
 
Q57.Which among the following is associated with Internet 
Mail? 
(a) Inbox (b) Server (c) Cursor 
(d) Dropbox (e) One Drive 
 
Q58.The fourth generation computers use which technology 
for both CPU and memory that allows millions of transistors 
on a single chip? 
(a) Vacuum Tubes (b) VLSI Technology  
(c) Cloud Computing (d) Generic Algorithm 
(e) None of the above 
 
Q59.In PowerPoint, what is the function of Alt+H? 
(a) Open the Transitions tab (b) Open the Home tab 
(c) Open the Insert tab (d) Open the Review tab 
(e) Open the Tell me box 
 
Q60.What is the shortcut key to move one word to the left in 
MS Word? 
(a) Tab + Left Arrow (b) Alt + Left Arrow 
(c) Shift + Left Arrow (d) Ctrl + Left Arrow  
(e) None of the above 
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Q61.When you save a Microsoft Access project, what file 
format do you use? 
(a) .adp (b) .Xml (c) .mbd 
(d) All of these (e) None of these 
 
Q62.The software that secretly collects information about 
the web client's internet habits? 
(a) Detect ware (b) Spam (c) Spyware 
(d) Pharming (e) All of these 
 
Q63.Which type of error in an algorithm that causes 
incorrect results? 
(a) Logical error (b) Syntax error (c) Machine Error 
(d) Compiler error (e) None of these 
 
Q64.Which of the following groups contains graphical file 
extensions? 
(a) JPG, GIF, BMP (b) GIF, TCF, WMF (c) TCP, JPG, BMP 
(d) ADP, GIF, PPT (e) JPG, CPX, GCM 
 
Q65. F12 opens which Dialog Box? 
(a) Font (b) New (c) Save 
(d) Save As (e) Help 
 
Q66.Two or more computers connected to each other for 
sharing information form a ________. 
(a) Router (b) Server (c) Network 
(d) Tunnel (e) Pipeline 
 
Q67.An online discussion group that allows direct ‘live’ 
communication is known as _________. 
(a) Web crawler  (b) Chat group  
(c) Regional service provider 
(d) Hyperlink  (e) E-mail 
 
Q68. A communication network which is used by large 
organizations over regional, national or global area is called 
_________. 
(a) LAN (b) WAN (c) MAN 
(d) Internet (e) None of these 
 
Q69. Encryption/decryption provides as network with _____. 
(a) Privacy (b) Authenticity (c) Integrity 
(d) Non-repudiation (e) Global Access 
 
Q70.Which one of the following is internet Standard 
Protocol? 
(a) TML (b) COBOL (c) JAVA 
(d) C++ (e) TCP/IP 
 
Q71. Name the network that is geographically distributed in 
a small area. For example, it allows connection among 
computers of two separate departments in a building. 
(a) LAN (b) WAN (c) TCP/IP 
(d) OSI (e) None of the above 
 

Q72. Operating system that allows only one user to work on 
a computer at a time is known as 
(a) Single user operating system  
(b) Multiuser operating system  
(c) Single tasking operating system 
(d) Multitasking operating system  
(e) Real time operating system 
 
Q73.Which of the following must be contained in a URL? 
(a) A protocol identifier (b) The letters, www  
(c) The unique registered domain name 
(d) WWW and the unique registered domain name  
(e) A protocol identifier, www and the unique registered 
domain name 
 
Q74.'Ctrl +Esc' is the shortcut key combination for? 
(a) Shows the start menu  
(b) shows the format menu  
(c) Shows the tools menu 
(d) shows the insert menu  
(e) None of the above 
 
Q75.A prescribed set of well-defined instructions for solving 
mathematical problems is called __________. 
(a) a compiler (b) a code (c) a description 
(d) an algorithm (e) None of these 
 
Q76._____________ is a service that allows organisations to 
make their own website. 
(a) Web hosting (b) Web surfing (c) Domain hosting 
(d) Linux hosting (e) Windows hosting 
 
Q77. Which of the following HTML tags is used to create a 
horizontal line on a Web page? 
(a) <hr> (b) <tr> (c) <line> 
(d) <hr1> (e) <line direction = “horizontal”> 
 
Q78.Bluetooth is an example of: 
(a) personal area network (b) local area network  
(c) virtual private network (d) wide area network  
(e) solid state storage 
 
Q79.In order to move from one worksheet to another in MS-
Excel workbook. One should click ___________. 
(a) active cell (b) scroll bar (c) sheet tab 
(d) tab button (e) None of these 
 
Q80.What does the LOOKUP function do? 
(a) Looks up text that contain ‘UP’  
(b) Used to look in a single row or column and find a value 
from the same position in a second row or column  
(c) Finds irrelevant records 
(d) All of above (e) None of the above 
 
Q81. Which of the following option in MS Word 2010 may be 
used to change page-size and margins? 
(a) Page Layout (b) View (c) Home 
(d) Data (e) Review 
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Q82.Which of the following devices is mainly used to draw 
objects in CAD? 
(a) Keyboard (b) Printer (c) Joystick 
(d) Scanner (e) None of these 
 
Q83. CCFL is used in LCD monitors for display. It stands for : 
(a) Cool Cathode Fluorescent Lamps  
(b) Cold Cathode Fluorescent Lights  
(c) Cold Cathode Fluorescent Lamps 
(d) Cool Cathode Fluorescent Lights  
(e) None of these 
 
Q84.The ………………. manual tells you how to use a software 
program. 
(a) documentation (b) programming (c) technical 
(d) user (e) None of these 
Q85.If a new device is attached to a computer, such as a 
printer or scanner, its……………. must be installed before the 
device can be used. 
(a) buffer (b) driver (c) pager 
(d) server (e) None of these 
 
Q86.Which of the following storage devices is used to 
compensate for difference in rates of flow of data from one 
device to another? 
(a) Floppy (b) Call (c) Channel 
(d) Buffer (e) Chip 
 
Q87.Pathways that support communication among the 
various electronic components on the computer system 
board are called _____________. 
(a) Wire Lines (b) Bus Lines (c) Logic Paths 
(d) Gateways (e)Network Lines 
 
Q88.In which types of network are all the computers 
considered equal? 
(a) Peer-to-peer (b) Client/server (c) Backbone 
(d) Hybrid (e) Hierarchy 
 
Q89. Personal computers can be connected together to form 
a _________. 
(a) Server (b) Super computer (c) Enterprise 
(d) Network (e) None of these 
 
Q90.Antivirus software is an example of: 
(a) business software (b) an operating 
system(c) a security utility (d) an office suite  
(e) none of these 
 
Q91.correcting errors in a program called: 
(a) Compiling (b) Debugging (c) Grinding 
(d) Interpreting (e) None of these 
 

Q92.Which of the following is a small microprocessor-based 
computer designed to be used by one person at a time? 
(a) Network (b) Supercomputer (c) All-in-one 
(d) Mainframe (e) Personal computer 
 
Q93. Which among the following term is used for those 
hardware devices that are not part of the main computer 
system and are often added later to the system? 
(a) clip art (b) highlight (c) execute 
(d) peripheral (e) None of these 
 
Q94. What is Direct X? 
(a) Operating system  
(b) Software that drives graphics hardware to enable game 
and multimedia to your system  
(c) Web browser 
(d) Word processing software  
(e) None of these 
 
Q95.What is backup? 
(a)Connect his network to more component  
(b)Copy to save a data from original source to other 
destination  
(c)Filter an old data from new data 
(d)Access data from tape  
(e)None of these 
 
Q96.The largest unit of storage is ……………….. 
(a) GB (b) KB (c) MB 
(d) TB (e) None of these 
 
Q97.The intersection of row and column is known as? 
(a) Column (b) Cell (c) Address 
(d) Attribute (e) Tuples 
 
Q98. What is the diagnostic testing sequence of a computer 
called that determines if all input and output devices are 
properly working? 
(a) rebooting (b) POST (c) scanning 
(d) defragmentation (e) BSoD 
 
Q99.Which of the following techniques can be used to store a 
large number of files in a small amount of storage space? 
(a) File adjustment (b) File copying  
(c) File compatibility (d) File compression  
(e) None of these 
 
Q100.__________ ensures secure transfer of data over an 
unsecured network, such as the Internet. 
(a) Antivirus (b) Hacking (c) Cracking 
(d) Spoofing (e) Cryptography 
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Solution 

 
S1.Ans.(a) 
Sol. Ctrl+F is the short cut key combination that can be used 
to search in Windows Explorer. 
 
S2.Ans.(b) 
Sol. ALU does the arithmetic and logical operations in a 
computer system. 
 
S3.Ans. (c) 
Sol. Desktop publishing (abbreviated DTP) is the creation of 
documents using page layout skills on a personal computer. 
 
S4.Ans. (a) 
Sol. HTML, Hyper Text Markup Language is used to create 
documents/pages for use on world wide web. 
 
S5.Ans. (d) 
Sol. There is no transition database. 
 
S6.Ans. (a) 
Sol. A repeater is an electronic device that receives a signal 
and retransmits it at a higher level or higher power, or onto 
the other side of an obstruction, so that the signal can cover 
longer distances. 
 
S7.Ans. (a) 
Sol. Java was introduced by Sun Microsystems. 
 
S8.Ans. (d) 
Sol. A blog is a regularly updated website or web page, 
typically one run by an individual or small group, that is 
written in an informal or conversational style. 
 
S9.Ans.(c) 
Sol. The first SIM card was developed in 1991 by Munich 
smart card maker Giesecke & Devrient, who sold the first 
300 SIM cards to the Finnish wireless network operator 
Radiolinja.A subscriber identity module is a removable smart 
card for mobile phones. SIM cards store the required 
information to identify the mobile device. 
 
S10.Ans.(d) 
Sol. VOIP is an acronym for Voice Over Internet Protocol, or 
in more common terms phone service over the Internet. If 
you have a reasonable quality Internet connection, you can 
get phone service delivered through your Internet 
connection instead of from your local phone company. 
 
S11.Ans. (e) 
Sol. All of the given options are different types of router 
functions. 
 
S12.Ans (d) 
Sol. Updating is periodically adding, changing and deleting 
file records 

S13.Ans. (b) 
Sol. An embedded system is a computer system with a 
dedicated function within a larger mechanical or electrical 
system, often with real-time computing constraints. It is 
embedded as part of a complete device often including 
hardware and mechanical parts. 
 
S14.Ans.(d) 
Sol.  A byte contains a combination of total eight 0s or 1s 
 
S15. Ans. (a) 
Sol.  In hexadecimal system there are 16 unique symbols. 
 
S16. Ans. (a) 
Sol. Login is the process of connecting/ accessing to an 
account. 
S17. Ans. (b) 
Sol. First computers were programmed using machine 
language. 
 
S18. Ans. (c) 
Sol. Super key is a set of one or more attributes taken 
collectively to uniquely identify a record 
 
S19. Ans.(b) 
Sol. Linux is can be used for various purposes i.e Web 
Serving(Nearly 60% of all websites on the Internet are run 
using an Open Source program named "Apache."), 
Networking, Databases, Scientific computing. 
 
S20. Ans. (c) 
Sol. LAN connection allows computers to share information 
and/or share peripheral equipment. 
 
S21.Ans.(d) 
Sol. An icon is a small graphical representation of a program 
or file that, when clicked on, will be run or opened. 
 
S22. Ans.(a) 
Sol. An applet is a program that runs in a Web browser. An 
applet can be a fully functional Java application because it 
has the entire Java API at its disposal. 
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S23.Ans. (a) 
Sol. Fingerprints are one of many forms of biometric used to 
identify individuals and verify their identity. 
 
S24.Ans.(a) 
Sol. The File Transfer Protocol (FTP) is a standard network 
protocol used to transfer computer files between a client and 
server on a computer network. 
 
S25. Ans. (a) 
Sol. Page Layout is used may be used to change page-size and 
margins. 
 
S26.Ans. (a) 
Sol. P2P stands for Peer to Peer. 
 
S27. Ans.(c) 
Sol. Software piracy is the illegal copying, distribution, or use 
of software. 
 
S28. Ans. (c) 
Sol. ‘.SYS’ extension refers to System files. 
 
S29. Ans.(d) 
Sol. A bootstrap is the process of starting up a computer. It 
also refers to the program that initializes the operating 
system (OS) during start-up. 
 
S30. Ans. (c) 
Sol. The insert, cap lock and num lock are all examples of 
Toggle keys. A toggle key toggles the input from a group of 
keys on a keyboard between two different input modes. 
 
S31. Ans. (b) 
Sol. Speed of line printer is specified in terms of Character per 
minute. 
 
S32. Ans. (a) 
Sol. EPROM is generally erased by using ultraviolet rays. 
 
S33.Ans.(a) 
Sol. RDBMS stands for Relational Database Management 
System. 
 
S34. Ans (e) 
Sol.  A draft is simply an email message you haven't yet sent. 
 
S35. Ans (e) 
Sol.  All are required to communicate between two computers. 
 
S36. Ans.(b) 
Sol. Except option (b) all others are the symptoms of a 
computer virus. 
 
S37. Ans.(b) 
Sol. When you want all your slides to contain the same fonts 
and images (such as logos), you can make those changes in 
one place—the Slide Master, and they'll be applied to all your 
slides. 

S38. Ans.(d) 
Sol. Adware is a software that is used to post unwanted 
advertisements. Generally, these advertisements are posted 
as pop-ups. 
 
S39. Ans (a) 
Sol. Multimedia is content that uses a combination of different 
content forms such as text, audio, images, animation, video 
and interactive content. 
 
S40. Ans.(c) 
Sol. FORTRAN is the best and only major programming 
language for scientific applications. It is designed for 
performing large and complex scientific numerical 
computing. 
 
S41.Ans.(b) 
Sol. Red underline- This indicates either a possible spelling 
error or that Word doesn't recognize a word, such as a proper 
name or place. Green underline- Word thinks that grammar 
should be revised. Blue underline- A word is spelled correctly 
but does not seem to be the correct word for the sentence. 
 
S42.Ans.(b) 
Sol. A hard disk drive (HDD), hard disk, hard drive or fixed 
disk is a data storage device used for storing and retrieving 
digital information using one or more rigid rapidly rotating 
disks (platters) coated with magnetic material. 
 
S43.Ans.(a) 
Sol. SQL is a language used to communicate with database. 
 
S44.Ans.(c) 
Sol. A relational database management system (RDBMS) is a 
database management system (DBMS) that is based on the 
relational model as invented by E. F. Codd. Relational 
databases have often replaced legacy hierarchical databases 
and network databases because they are easier to understand 
and use. 
 
S45.Ans.(b) 
Sol. Reboots can be either cold (alternatively known as hard) 
where the power to the system is physically turned off and 
back on again, causing an initial boot of the machine, or warm 
(alternatively known as soft) where the system restarts 
without the need to interrupt the power. 
 
S46.Ans.(e) 
Sol. Firewall is a network security system that monitors and 
controls the incoming and outgoing network traffic based on 
predetermined security rules. It typically establishes a barrier 
between a trusted, secure internal network and another 
outside network, such as the Internet, that is assumed not to 
be secure or trusted. 
 
S47.Ans.(b) 
Sol. A page break is a marker in an electronic document that 
tells the document interpreter that the content which follows 
is part of a new page. 
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S48.Ans (c) 
Sol. A web browser (commonly referred to as a browser) is a 
software application for retrieving, presenting and traversing 
information resources on the World Wide Web. 
 
S49.Ans (c) 
Sol. An Ad-Hoc Query is a query that cannot be determined 
prior to the moment the query is issued. It is created in order 
to get information when need arises and it consists of 
dynamically constructed SQL which is usually constructed by 
desktop-resident query tools. 
 
S50.Ans. (b) 
Sol. DRAM stands for Dynamic Random Access Memory. 
 
S51.Ans (c) 
Sol. An assembly (or assembler) language, is a low-level 
programming language for a computer, or other 
programmable device 
 
S52.Ans.(a) 
Sol. A calculated column uses a single formula that adjusts for 
each row. It automatically expands to include additional rows 
so that the formula is immediately extended to those rows. 
 
S53.Ans.(e) 
Sol. Video Card is an expansion card which generates a feed of 
output images to a display 
S54.Ans.(d) 
Sol. Feedback occurs when outputs of a system are routed 
back as inputs as part of a chain of cause-and-effect that forms 
a circuit or loop. The system can then be said to feed back into 
itself. 
 
S55.Ans.(a) 
Sol. Animation is a special visual and audio effect applied in 
PowerPoint 
 
S56.Ans (a) 
Sol. TeamViewer is a proprietary computer software package 
for remote connection, desktop sharing, online meetings, web 
conferencing and file transfer between computers. 
 
S57.Ans.(a) 
Sol. Inbox is the name given to the folder where your newly-
delivered email messages appear. 
 
S58.Ans.(b) 
Sol. Very-large-scale integration (VLSI) is the process of 
creating an integrated circuit (IC) by combining thousands of 
transistors into a single chip. 
 
S59.Ans.(b) 
Sol. Alt+H opens the home tab in PowerPoint. 
 
S60.Ans.(d) 
Sol. Ctrl + Left Arrow is the shortcut key combination to move 
one word to the left. 
 

S61.Ans.(a) 
Sol. ADP is a data file format created by Microsoft Access. 
 
S62.Ans.(c) 
Sol. Spyware is a software that enables a user to obtain covert 
information about another's computer activities by 
transmitting data covertly from their hard drive. 
 
S63.Ans.(a) 
Sol. Logical errors occur when the program runs without 
crashing, but produces an incorrect result. The error is caused 
by a mistake in the program's logic. 
 
S64.Ans (a) 
Sol. JPG, GIF, BMP are graphical file extensions 
 
S65.Ans (d) 
Sol. F12 functional key displays save-as dialog box. 
 
S66.Ans.(c) 
Sol. A network is interconnection of two or more computers. 
 
S67.Ans.(b) 
Sol. Chat group is an online discussion group that allows 
direct ‘live’ communication. 
 
S68.Ans.(b) 
Sol. WAN is spread widely across geographical area. 
 
S69.Ans.(a) 
Sol. Encryption/decryption provides as network with Privacy. 
 
S70.Ans.(e) 
Sol. TCP/IP, which stands for Transmission control 
Protocol/Internet Protocol, is an industry-standard protocol 
suite for WANs. On the other hand, HTML, COBOL, JAVA and 
C++ are computer programming languages. 
 
S71.Ans.(a) 
Sol. LAN is a privately owned network of an organisation. It is 
used to connect a computer with additional hardware, such as 
a printer, at home or in office. The range of LAN is restricted 
to a few kilometers only. It is more reliable and better speed 
for small area. 
 
S72.Ans.(a) 
Sol. Single user operating system allows only one user to work 
on a computer at a time. An example of single user operating 
system is MS-DOS. 
 
S73.Ans. (e) 
Sol. A protocol identifier, www and the unique registered 
domain name are requisite for a URL 
 
S74.Ans.(a) 
Sol. 'Ctrl +Esc' is used to show the start menu. 
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S75.Ans (d) 
Sol. An algorithm is a self-contained step-by-step set of 
operations to be performed. Algorithms perform calculation, 
data processing, and/or automated reasoning tasks. 
S76.Ans.(a) 
Sol. Web hosting is a service that allows organisations to make 
their own website accessible through WWW. This service 
allows you to share the data on the Web or the Internet by 
storing your Web page on the Internet. 
 
S77.Ans.(a) 
Sol. In HTML, you can create a horizontal line on a Web page 
by using the <hr>tag. The purpose of the <hr> tag is to 
separate paragraphs or sections on a Web page. 
 
S78.Ans.(a) 
Sol. A personal area network (PAN) is a computer network 
used for data transmission amongst devices such as 
computers, telephones, tablets and personal digital assistants. 
Bluetooth is an example of the same. 
 
S79.Ans.(c) 
Sol. Sheet Tab is used to switch between worksheets. 
 
S80.Ans.(b) 
Sol. LOOKUP function is used to look in a single row or column 
and find a value from the same position in a second row or 
column. 
 
S81.Ans.(a) 
Sol. In MS Word, Margins, Size and Orientation is available in 
Page Setup under Page Layout Tab. 
 
S82.Ans.(c) 
Sol. Joystick is used to draw objects in Computer-Aided Design 
(CAD). 
 
S83. Ans.(c) 
Sol. CCFLs stands for Cold Cathode Fluorescent Lamps. 
 
S84.Ans.(d) 
Sol. User manual provides you detailed installation and un-
installation instructions, system requirements, step-by-step 
operation, etc. 
 
S85.Ans.(b) 
Sol. A device driver or hardware driver is a group of files that 

enable one or more hardware devices to communicate with 

the computer's operating system. Without drivers, the 

computer would not be able to send and receive data correctly 

to hardware devices, such as a printer. 
 

S86.Ans.(d) 

Sol. Buffer is used to hold data temporarily inside the 

computer memory. When different devices require the data, 

the buffer sends it on a priority basis, thereby differentiating 

the flow of data between the devices. 

 
S87.Ans.(b) 
Sol. A system bus comprises of cables and connectors that 
carries data between main memory of a computer and 
microprocessor. 
S88.Ans.(a) 
Sol. The peer-to-peer network is a type of network where each 
computer is connected to the other to share resources 
without requiring a separate server system. In this network, 
computers can be connected via an ad-hoc connection. 
 
S89. Ans.(d) 
Sol. Personal computers are connected together through a 
LAN; this arrangement of computers forms a network. 
 
S90.Ans.(c) 
 
S91.Ans.(b) 
Sol. Debugging is the process of finding and fixing program 
errors. 
 
S92.Ans.(e) 
Sol. Personal Computers (PCs) are designed for a single user. 
They come with built-in memory and a small microprocessor. 
 
S93.Ans. (d) 
Sol. A peripheral device is generally defined as any auxiliary 
device such as a computer mouse or keyboard that connects 
to and works with the computer in some way. 
 
S94. Ans. (b) 
Sol. Microsoft DirectX is a collection of application 
programming interfaces (APIs) for handling tasks related to 
multimedia, especially game programming and video, on 
Microsoft platforms. 
 
S95.Ans.(b) 
 
S96.Ans.(d) 
Sol. Tera byte(TB) is the largest unit of storage. 
1 TB= 1024 GB 
 
S97.Ans.(b) 
S98. Ans.(b) 
Sol. POST is a diagnostic testing sequence of a computer that 
is run before the actual booting to ensure that the computer 
hardware is functioning well. It stands for ‘Power-On Self-
Test’. 
 
S99.Ans.(d) 
Sol. File compression is the technique used to store the large 
file in a small storage space. It compresses to content of the 
file in such a way that there is no harm done on the file content 
and quality. 
 
S100.Ans.(e) 
Sol. In cryptography, data are sent in such a way that they look 
completely different from the original data. Thus, 
cryptography ensures secure transfer of data over an 
unsecured network. 
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